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Notice: This document contains information on products in the design phase of development. The information here is subject to change without
notice. Do not finalize a design with this information.

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL PRODUCTS. NO LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR
OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN INTEL'S TERMS AND
CONDITIONS OF SALE FOR SUCH PRODUCTS, INTEL ASSUMES NO LIABILITY WHATSOEVER AND INTEL DISCLAIMS ANY EXPRESS OR IMPLIED
WARRANTY, RELATING TO SALE AND/OR USE OF INTEL PRODUCTS INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A
PARTICULAR PURPOSE, MERCHANTABILITY, OR INFRINGEMENT OF ANY PATENT, COPYRIGHT OR OTHER INTELLECTUAL PROPERTY RIGHT.
UNLESS OTHERWISE AGREED IN WRITING BY INTEL, THE INTEL PRODUCTS ARE NOT DESIGNED NOR INTENDED FOR ANY APPLICATION IN WHICH
THE FAILURE OF THE INTEL PRODUCT COULD CREATE A SITUATION WHERE PERSONAL INJURY OR DEATH MAY OCCUR.

Intel may make changes to specifications and product descriptions at any time, without notice. Designers must not rely on the absence or
characteristics of any features or instructions marked “reserved” or “undefined.” Intel reserves these for future definition and shall have no
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The information here is subject to change without
notice. Do not finalize a design with this information.

This specification, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the terms of
the license. The information in this document is furnished for informational use only, is subject to change without notice, and should not be construed

as a commitment by Intel Corporation. Intel Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear in this
document or any software that may be provided in association with this document.

Intel processor numbers are not a measure of performance. Processor numbers differentiate features within each processor family, not across
different processor families. See www.intel.com/products/processor_number for details.

Intel AMT requires the computer system to have an Intel AMT-enabled chipset, network hardware and software, as well as connection with a power
source and a corporate network connection. Setup requires configuration by the purchaser and may require scripting with the management console
or further integration into existing security frameworks to enable certain functionality. It may also require modifications of implementation of new

business processes. With regard to notebooks, Intel AMT may not be available or certain capabilities may be limited over a host OS-based VPN or
when connecting wirelessly, on battery power, sleeping, hibernating or powered off. For more information, see
http://www.intel.com/technology/platform-technology/intel-amt/.

The Intel® Platform Enablement Test Suite described in this document may contain design defects or errors known as errata— including KVM, AT, IPT,
AMT, SBA, processor numbering, software source code if applicable—which may cause the product to deviate from published specifications. Current
characterized errata are available on request.

Code Names are for use by Intel to identify products, platforms, programs, services, etc. (“products”) in development by Intel that have not been made
commercially available to the public, i.e., launched or shipped. They are never to be used as “commercial” names for products or intended to function
as trademarks.

Contact your local Intel sales office or your distributor to obtain the latest specifications and before placing your product order.

Copies of documents which have an order number and are referenced in this document, or other Intel literature, may be obtained by calling 1-800-
548-4725, or by visiting Intel's Web Site.

Intel, the Intel Logo, Celeron, Pentium, and Atom are trademarks of Intel Corporation in the U.S. and other countries.
*Other names and brands may be claimed as the property of others.
Copyright © 2019-2020, Intel Corporation. All rights reserved.
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1 Introduction

The purpose of this document is to describe the installation of Intel® Platform Enablement Test Suite (Intel®
PETS) and how to use it to test Intel® Management Engine (Intel® ME) and Intel® Trusted Execution Engine
(Intel® TXE) supported platforms (desktop, mobile and workstation).

1.1 Overview

This chapter provides a brief description of the Intel® Platform Enablement Test Suite. It contains the
following sections:

e Introduction to Intel® Platform Enablement Test Suite

e Package Contents

e |nstallation, Setup. and Testing Flow

1.1.1Introduction to Intel® Platform Enablement Test Suite

The Intel® Platform Enablement Test Suite is a one-stop GUI application for the comprehensive automated
testing of Intel® ME and Intel® TXE firmware. The Intel® Platform Enablement Test Suite automates a large
number of the tests in the Compliancy Guide, significantly reducing testing time. The Intel® Platform
Enablement Test Suite can be used by OEMs, ODMs, and Intel testing teams.

The Intel® Platform Enablement Test Suite is run on a testing machine that has access, via LAN or WLAN, to an
Intel” ME/TXE System under Test (SUT), including its file system. The Intel® Platform Enablement Test Suite
executes tests on the SUT and displays the test results, clearly indicating the tests that succeeded and those
that failed.

For the tests that require the performance of power-related operations, the Intel® Platform Enablement Test
Suite should be connected to the SUT through one of the following methods:

e If the tests require many power-related operations - the Intel® Platform Enablement Test Suite should be
connected to the SUT via a dedicated Intel® PETS Automated Power Provider (Ex: Intel® APS).

e If the tests require just a few power-related operations - the Intel® Platform Enablement Test Suite can
be connected directly to the SUT.

The following diagram shows an architectural overview of the Intel® Platform Enablement Test Suite
environment:
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Figure 1-1. Testing Environment Diagram
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1.1.2Package Contents

The package contains the following:
¢ Intel® PETS application.
e Test Packages (including test sets, XMLs, and local agent).
e Documentation:

— Intel® Platform Enablement Test Suite Installation and User Guide (this document).
1.1.3Installation, Setup, and Testing Flow

To be able to use the Intel® Platform Enablement Test Suite, follow these steps:
1. Check the requirements for the testing machine and for the SUT. For details, see Chapter 2, "System
Requirements"

2. Set up and configure the Intel AMT machine. For details, see Chapter 3, "Setting Up the Intel® AMT
Platform".

3. Install the Intel® Platform Enablement Test Suite on the testing machine. For details, see Chapter 4,
"Installation".
4. connect and set up the Automated Power Switch (Ex: see the Intel Automated Power Switch (Intel® APS)
Connection and Setup Guide for OEMs)
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5. Configure the connection of the Intel® Platform Enablement Test Suite with the "System under Test".
For details, see Chapter 5, "Defining an Intel® Platform for Testing".

6. Run the “SetupEnvironmentTest” test package to validate all connections and their functionality. For
details, see Chapter 5, "Defining an Intel® Platform for Testing".

7. Run tests. For details, see Chapter 6, "Defining an Intel® Platform Enablement Test Suite".

8. View Test Results. For details, see Chapter 6, "Viewing, Saving, and Sending Test Reports".

9. Adjust the package parameters of the test package where necessary. For details, see Chapter 7,
"Changing Package Parameters".

10. Add unique SPI flash parts specifications to be checked during related tests. For details, see Chapter 8,
"Changing General Parameters"

1.1.4 Intel® PETS Prerequisites Manager

1.1.4.1 Automatic Configuration for Prerequisites Manager

1. Inmain PETS GUI - Go to Tools > Prerequisites Manager.

& Intel(R) Platform Enablement Test Suite
Package View Settings Run Report m Help

—

2. The Prerequisites Manager dialog will be displayed:

[ Prereguisites Manager - o E

Select Mame | Download Link | Download Path | Description | Status

BostableiSOimage s a bootalble IS0 mage
= BootablelSOimadd hitp Vdistiles gentoo ofg'relea CUPET S\Bootableln that = used in Redwechon lests{Corporate
SHLUS only)
BoolablelSOimags 13 & Secianed
&1 SecuredBociablel] hitps download fedoraprojec C IS0 image that is used in
Hedirecton testsiCanmo SELS onk

rer exe 15 & siands o[
e Lisad 1o ¢
'}a et S heann feahml comedowl G PETSWHNOYiewe : > s
tesis This PP 5 e SO0
Corporale SELS th ppart KYM

oy BUWI SESasnn an

*  The files specified in the dialog are required for Intel® AMT — KVM & SOL testing:
o Secured ISO image file required for AMT_036 test.

o Bootable ISO Image file required for SOL tests.

Intel Confidential 11



®
Introduction I n tel

o VNC Viewer executable file required for KVM tests.

*  For each file, the download link and the download path are specified in the dialog with a brief
description.

*  The “Status” column shows the wording “Ready”, indicating the files are ready to be downloaded.
*  The Dialog has 4 buttons:

o Load Defaults: This will revert the “download link” which is an “editable field’ to it's original
value in case the user changed it and wants to get back to the default link.

o Download: This will start the download process. Make sure you are connected to the Internet
before starting the download process.

o Cancel: To cancel the process & close this dialog.
o Save Changes: To save the changes the user made on the “Download link “.

3. Click download to start downloading, a progress dialog will appear.

i =
Select | Name Download Link Download Path  Description | Status

BootableliSOlmage is a bootable IS0 image
= BootablelSOlmage hitp /idistfiles gentoo. orglrelea; CIPETS \Bootlablelm| that is used in Redirection tests{Corporate Downloading
SKUs only}
SecuredBoatablelS0Imags IS a secured
= SecuredBootablelS hitps://download fedoraproject C\PETS'\Eootableim| bootable 150 image that is used ir Ready
R on tests{Corporate SKUs only)
VMCViewer exe is a standalone application
| that is wsed to open KVM session in KVM Ready
tests. This application is required for !
. Corporate SKUs that support K
|i Downloading Bootablel50image Size 348 MBytes )

WMNCViewer hitps./fwww_reahmc.comfdowr CIPETSWNCViewer

Note: The prerequisites Manager window will not open in case there is no internet connection.
The following Notice window will pop up:

Motice

Mo intemet connection. Please check your connection and try again. Ctherwise, refer to the
following section (1.1.4.2 Offline Installation of AMT tests prerequisites) in the PETS user
guide.
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Once the process ids finished, the status column will be updated with either “Succeeded” indicating the download
is successfully complete and located in c:\PETS directory, or “Failed” indicating the download has been
interrupted due to one of the following errors:

o Internet Connection is lost during the download process.
o There's no space left on the Disk.

4. |If the download is successfully complete, the files should be located in folders in the directory c:\PETS.

Clipboara Urganize New Upen select
T » ThisPC > Windows (C) » PETS v O

Mame Date modified Type Size
access

911:11 File folder
911:13 File folder

Bootablelmages
op .
VNCViewer

loads

1.1.4.2 Offline Installation of AMT tests prerequisites

In case the Management Console doesn't have an internet connection, the user has to do the following
steps in order to install the following prerequisites:

1. VNC Viewer:

1- Download VNC Viewer standalone executable version (x86) from_https://www.realvnc.com
For Example:

https://www.realvnc.com/download/file/viewer.files/VNC-Viewer-6.19.715-Windows-32bit.exe

2- Copy the download executable file to the Management Console
3- Place the downloaded executable file into “C:\PETS\VNCViewer\ “directory
4- Rename the downloaded file to “VNCViewer”

Note: It is recommended to use VNC viewer version 6.19.715 or higher since the earlier
versions (i.e 5.x) are not supported.

2. Bootable ISO Image file:

1- Open http://distfiles.gentoo.org/releases/amd64/autobuilds/current-install-amd64-minimal/
2- Locate “install-amd64-minimal-[buildDate].iso” where the “buildDate” is the number of the
build used for the ISO, e.g. install-amd64-minimal-20190721T214502Z.iso

Intel Confidential 13
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Click on the file to download

Copy the downloaded ISO image to the Management Console .

Place the downloaded Image file into “C:\PETS\Bootablelmages\"” directory
Rename the downloaded Image file to “Non_Secure_Redirection_Image.iso”

Note: Users can use any ISO images as along as the boot menu of the image is text only
(since Putty supports texts only) by following these steps:

1. Copy the downloaded ISO image to the Management Console.
2. Place the downloaded Image file into “C:\PETS\Bootablelmages\" directory.
3. Rename the downloaded Image file to “Non_Secure_Redirection_Image.iso”

3. Bootable Secured ISO image:

14
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Open https://getfedora.org/en/server/download/

Download a secure ISO image from the link:

e.g. Fedora 31: Netinstall ISO image for x86_64

Copy the downloaded ISO image to the Management Console .

Place the downloaded Image file into “C:\PETS\Bootablelmages\" directory
Rename the downloaded Image file to “Secured_Redirection_Image.iso” .
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2 System Requirements

This chapter describes the requirements for installing and running the Intel® Platform Enablement Test Suite.
The following topics are included:

e Testing Machine Requirements

e Requirements for "System Under Test"

2.1 Testing Machine Requirements

This section describes the requirements of the testing machine.

e Operating system: Windows* 7 32 or 64 bit (with IE 9 and above) with SPI, Windows* 8 32 or 64 bit,
Windows* 8.1 32 or 64 bit, or Windows* Pro 10 32 or 64 bit.

e _.Net framework 4.8 needs to be installed on the testing machine

- Hereis alist of windows releases and the .NET framework version which was included in each
release.

https://blogs.msdn.microsoft.com/astebner/2007/03/14/mailbag-what-version-of-the-net-
framework-is-included-in-what-version-of-the-os/

- Please note that PETS installers also checks for .NET 4.8 and if not installed, it should bring a
dialog message asking to install it before starting the installation.

- If the users want a manual steps to verify the .NET version installed on any OS, they can check
the registry, see this link for more details:

https://docs.microsoft.com/en-us/dotnet/framework/migration-guide/how-to-determine-
which-versions-are-installed

e Management Console should have The Visual C++ Redistributable Packages(x86 & x64) installed.

e Microsoft* NET Framework 4.8 (downloadable from this
https://dotnet.microsoft.com/download/dotnet-framework/net48).

e A network connection.

e The testing computer must be connected to the Automated Power Switch via its USB port (Ex: Intel® APS
3.x)

e Reporting. In order to avoid an Active X popping up when you open a report with a web browser, you
must set your browser to allow active content to run on your computer. To set Internet Explorer to allow
active content:

a. Choose Tools > Internet Options; the Internet Options dialog appears.
b. Select Advanced > Security > Allow active content to run in files on My Computer.

c. Click OK.

Note: Intel® Platform Enablement Test Suite has been designed and tested using the default Windows* theme and
colors. Using other themes and colors may result in making some buttons invisible.
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2.2 Requirements for the "System Under Test"

This section describes the requirements for the system you are testing. The following table details the
currently supported SUT platforms in Intel® PETS.

Refer to the latest Intel® PETS Release Notes for more information on Intel® PETS versions supporting current
and legacy platforms.

Platform version

Platform PCH cPU '"tf:;vME in PETS SUT 0S Support
Creation wizard
Elkhart MCC EHL Intel® CSE CSE15.40 Windows* 10
Lake (EHL) 15.40 ElkartLake
JasperLake ICL EHL Intel CSME CSME13.50 Windows* 10
(IsL) 13.50 JasperLake
Tiger Lake ®
2 TGL-LP TGL-U Intel® CSME  -oME 15 TigerLake  Windows* 10
(TGL) 15.0
CML-V CML-S Intel CSME CSME14.5 Windows* 10
ColISBLats 14.5 CometlLake
(CML-V) ’
Comet Lake CML_LP Intel® CSME CSME 14 - .
(CML) CML-H CRENEU 14.0 CometLake LTI
Ice Lake Intel® CSME . "
(cu) ICL_LP ICL-U 13.0 CSME13 IceLake Windows* 10
Whiskey Lak Intel® CSME CoME12
BAEYIELG R s WhiskeyLake i *
(WHL) CNL_LP WHL-U 12.0 W Windows* 10
Cannon Lake o
CNL-LP CNL-U/Y D Windows* 10
12.0 CannonlLake
(CNL)
Coffee Lake CNL-H CFL-U/S/H Intel* CSME ~ CSME 12 Windows* 10
(CFL) CNL-LP 12.0 CoffeelLake
Intel® CSME CSME 12 . .
CNL-H CFL-S 12.0 CoffecLake Windows* 10
Gemini Lake Intel® TXE ) *
(GLK) N/A GLK A1 40 GLK Windows* 10
APL . .
Apollo Lake N/A Intel® Celeron/ Intel® TXE Windows* 7 (64 bit)
(APL) Pentium Processors 3.0 Windows* 10

The following are requirements of the SUT:

e Microsoft* NET Framework 4.8 (downloadable from this Framework Link )

16
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e Provisioned platform (except for specific tests that require an un-provisioned system as the starting
state).

¢ Intel® ME/TXE drivers (LMS, Intel® Management Engine Interface (Intel” MEI), SOL, WMIProvider,
TXEI_Driver) must be installed on the platform from the firmware kit.

e Graphics driver that suits the video card.
e A network connection.
e Wireless connection to the network (for applicable platforms only).

e For Intel® ME/TXE platforms, the Intel” System Scope Tool (Intel” SST) is required. The Intel” SST should
be installed on the SUT. The SysScope installer is available in the Compliance kit.

Note: Intel® PETS currently supports Intel® SST version 3.x and will no longer supports older versions of the tool.

Note: In case Intel® SST was not installed on the SUT, Intel® PETS will continue to run tests and a failure dialog will
NOT appear to the user. However, the report viewer will display a log message under the “System under
Test” section that states “System Scope tool is Not Installed”.

Note: In case Intel® PETS encounters issues with Intel® SST (i.e. Installation, running the tool), or an unsupported
version of the tool was being used, Intel® PETS will try to run the tool for one minute. If these issues persist
to occur, a failure message dialog box will pop up to the user. “System Scope tool failed to run” will be
displayed in Intel® PETS logs in the report viewer “System under Test” section.

Note: Upon successful installation and running of Intel® SST, a link will be displayed in the log message under
“System under Test" so that the user can view the system scope information details.
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3 Setting Up an Intel® AMT Platform

This chapter describes how to set up an Intel® AMT platform for testing by the Intel® Platform Enablement
Test Suite. The following topics are included:

e Setup.

e  Setting up non-Intel® AMT Platforms.

3.1 Setup

To enable the correct flow of tests in the Intel® Platform Enablement Test Suite, do the following on Intel®
ME platform:

1. Create a Windows* admin user ,or use an existing user and assign a password to that user.
2. Setup Auto-Login using this user as follows:
a. Click the Start Menu then type “regedit” and hit enter.

b. Add the following entries and values to HKEY_LOCAL_MACHINE -> Software -> Microsoft ->
Windows NT -> CurrentVersion -> Winlogon:
e AutoAdminLogon (DWORD): 1
e DefaultUserName (string): Administrator user name
e DefaultPassword (string): Password for the Administrator user
After you have made the changes, the Registry should look like the following screenshot:

] |

File Edit View Fgvorites Help

T = || Namne Type Data
Windows
T ol Ynegen l:': AutaAdminLogon REG_DWORD 0400000001 (1) I
AutoLogonChecke
GPExtension: - =
NM,,: = 5| Background REG_SZ 000
Winsat a5 CachesdLogonsC... REG_SZ 10

WinSATAF] "C

wow 0| DefaultPassword

WUDF 2| DefaultUserMame
‘Windows Photo Viewer

Windows Postable Devices
Windews Seript Host

REG_SZ
REG_SZ

P@sewlnd
Administrator

| FereeUnlockLog...
5] LegaibloticeCap.

REG_DWORD
REG_SZ

000000000 {0)

Windows Search s¥) LegalMoticeText  REG 52
Wisp 1) PasswerdExpiry..  REG_DWORD 000000005 (5)
Wilangwe a¥| Powerdownifte.. REG_SZ o
Wordzpaces ab| PreCreateknow... REG_SZ {AS20A1A4-1780-4FFG-BO18-167343C5AF16}
WwanSve 25| ReportBoatOk REG_SZ 1
opBeC a¥| seremovecption  REG_SZ 0
FAbiGhcpbice 25| Shell REG_SZ explorer.exe
Policies B4 shutdownFlags  REG_DWORD OaDOB0000b (11)
eguisilipplicstions ¥ ShusdownWithe., REG_SZ 0
\5:.::, s = || 28] Userinat REG_SZ CAWfindows\system3Xuseninit.exe, -
= r it '
Computer\ HKEY_LOCAL_MACHINE\SOFTWARE\ W s NT\Curr

3. Disable Windows* firewall from the Device Manager entry.

4. Ifyou are not using an Intel” NIC and want to run tests using the Host Wake On LAN feature, configure
the LAN Driver as follows:

a. Right-click My Computer and choose Manage; the Computer Management dialog appears.
b. Select Device Manager in the left pane and expand Network adapters in the right pane.

c. Configure your network adapter to wake on magic packet and not wake on direct packet. Each
driver will have different steps for enabling the 'Wake on Magic Packet' feature.
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5. Choose Start > Settings > Control Panel > Administrative Tools > Local Security Policy > Local
Policies > Security Options > Network Access: Sharing and security Model for local accounts and
select Classic from the drop-down list.

6. Configure the system to not require a password on wakeup, and to shut down when the Power button is
pressed. For example, to do this in Windows*:

a. Open the Control Panel and choose System and Maintenance > Power Options.

b. Click the “Require a password on wakeup” link.

c. Select “Don't require a password” in the “Password protection on wakeup” section.
d. Select “Shutdown” in the “When | press the power button” list.

7. Make sure that Intel® AMT platform is provisioned with a host name and domain. (You can use any
strings for the two fields - they do not need to be valid names). You can do this in a number of ways:

— Enter the values in the System Name Settings section of the Web UL.

— Enter the values via Intel” Management Engine BIOS Extension (Intel” MEBX) by choosing CTRL-
P during the boot sequence.

— Enter the values with a setup and configuration server.
8.Enable Host Wake On LAN (magic packet) on the system under test:
a. Enable Host Wake on LAN in BIOS.
b. Open the Device Manager.
c. Double-click on the Eth device; the device's Properties dialog appears.

d. Follow the instructions for your operating system:
i. Selectthe “Power Management” tab.
ii. Enable “Wake on Magic Packet” and Wake on Magic Packet from off state”.
iii. Disable “Wake on Link".
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4 Installation

This chapter describes how to install “Intel® Platform Enablement Test Suite” and the “local agent”. The
following topics are included:

4.1

10.

Installing Intel® Platform Enablement test Suite

Installing the Local Agent on Windows*

Installing the Local Agent on Android (TXE platforms only)

Post Validation Verification (APS)

Installing Intel® Platform Enablement Test Suite

Verify that the testing computer meets the system requirements. For details, see Testing Machine
Requirements.

Make sure you are logged into the testing computer as an Administrator.
Extract the Intel® Platform Enablement Test Suite files to a folder on the testing computer.

Locate and double-click the installation file (<installation package>\Console\PETSConsole.msi) to
launch the Intel® Platform Enablement Test Suite Install Shield Wizard.

Click “Next” in the Welcome screen.

Click “l accept the terms of the license agreement” and “Next” in the License Agreement screen.

Click “Next"” in the Choose Destination Location screen to install Intel® Platform Enablement Test Suite
in the default installation folder. To install in a different location, click “Change”. The default installation
folder is “C:\Program files\Intel\Intel(R) Platform Enablement Test Suite".

Click “Next" in the Setup Type screen.

Click “Install” in the “Ready to Install the Program” screen to begin installing Intel® Platform
Enablement Test Suite; a progress bar appears showing the status of the installation.

Click “Finish” in the “Install Shield Wizard Complete” screen to exit Intel® Platform Enablement Test
Suite Setup wizard.

Starting from Intel® PETS version 8.19.0, a warning message will appear to the user if the release date of
Intel® PETS build in use is older than 60 days. The warning message will ask for confirmation if the user
chooses to proceed using the outdated build.

20

Old Version of PETS

Waming!!! You are using an old PETS version which was released on February 14, 2016,
Using an old PETS version might cause failures. Are you sure you want to proceed 7
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4.2 Installing the Local Agent on Windows*

The local agent must be installed on each SUT.

To install the Local Agent:

1. Put the Intel® Platform Enablement Test Suite files on the SUT in one of the following ways:

— Extract the Intel® Platform Enablement Test Suite files to a folder on the SUT.

— Copy the PETSLocalAgent folder over to the SUT.

2. Locate and double-click this installation file on the SUT: <installation
package>\Agent\PETSLocalAgent.msi

3. Configure the Windows* Event Viewer to Overwrite events as needed in the following way:

ntel)

a. Choose Control Panel > Administrative Tools > Event Viewer to open the Event Viewer.

b. Choose Action > Properties to open the Properties dialog.

c. Select the Overwrite events as needed option and click OK.

The Overwrite events as needed option is selected by default in Windows* 7 and Windows* 8 (SUT only).

4.3 Installing and Uninstalling Intel® PETS in silent mode

To install Intel® PETS Console in silent mode, navigate to the Console folder in the downloaded Intel® PETS

kit and run the following command “msiexec /i PETSConsole.msi /qn” , where:

e [i parameter for installing the specified .msi file.

e /gn parameter for a silent installation that displays no user interface.

To install Intel® PETS Local Agent in silent mode, navigate to the Agent folder in the downloaded Intel® PETS
kit and run the following command “msiexec /i PETSLocalAgent.msi /qn”

The following dialog appears requesting confirmation from the user only for first time installation of Intel®
PETS agent on a clean OS:

El

Would you like to install this device software?

MName: Intel Corporation System devices

ILQ Publisher: Intel(R) Embedded Subsystems and IP Bloc...

%] Always trust software from “Intel(R) Embedded
Subsystems and IP Bloc...".

Install

@) You should only install driver software from publishers you trust. How can | decide which device software is

To uninstall Intel® PETS Console in silent mode, navigate to the Console folder in the downloaded Intel®
PETS kit and run the following command “msiexec /x PETSConsole.msi /qn”, where:

e [x parameter for uninstalling the specified .msi file.

Intel Confidential
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To uninstall Intel® PETS Agent in silent mode navigate to the Agent folder in the downloaded Intel® PETS kit
and run the following command “msiexec /x PETSlocalAgent.msi /qn”

4.4 PostInstallation Verification

After you have installed and set up Intel® Platform Enablement Test Suite, you can use Automated Power
Provider Software (Ex: Intel® APS ) to verify that it is properly connected by performing power transitions on
the SUT.
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5 Defining an Intel Platform for Testing

This chapter describes how to define an Intel platform for testing by the Intel® Platform Enablement Test
Suite. This must be done before running tests on that platform.

This chapter covers the following topics:

. Opening Intel® Platform Enablement Test Suite

° Opening Intel® Platform Enablement Test Suite from the Command Line

° Defining the Intel® System Under Test

. Systems Under Test Dialog

° Testing the Configuration of the SUT

To configure Intel® Platform Enablement Test Suite, perform the following:
1. Open Intel® Platform Enablement Test Suite.

2. Configure the system under test (SUT) by defining its parameters.

3. Test the connectivity with the SUT.

4. Test the setup of the SUT.

Note: You should also run the connectivity and setup tests whenever there is a change in the environment (e.g.,
you select another SUT to be tested).

5.1 Opening Intel® Platform Enablement Test Suite

Choose Start > Programs > Intel > Intel® Platform Enablement Test Suite; the Intel® Platform Enablement
Test Suite window appears.

5.2 Opening Intel® Platform Enablement Test Suite from the
Command Line
5.2.1 Command line for semi-automated tests

Using the help option “~2" will list all the supported options:

o Runand Close.
o Open package in GUI.

Follow these guidelines to run those tests using the Command Line:
1. Open a new command line window as an administrator.

2. Navigate to the PETS installation director
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B Administraton: C\Windows\System22\cmad.exe =

on b.1.76H1 ] -
soft Copporation. ALl erights reserved.

3. Type one of the following commands:

a. For Run and Close test:

Run_PETS.bat -run -package "full package path" -sut "SUT Name in PETS".

b. For Open package in GUI test:
Run_PETS.bat -Open -package "full package path" —-sut “SUT Name in PETS".

Where:

= The “full package path” is the full path for the package you want to run.

= The "SUT Name in PETS" is the name of the SUT that you should define in PETS before you
run the test. This SUT can only be defined in the GUI mode (but not in the command line
mode).

Intel® PETS runs and closes automatically when execution finishes. If all the tests pass, an Exit Code
of O is returned. If one or more tests fail, the Exit Code is 1, and if there is a configuration error, the
Exit Code is -1. For example:

If you have a package on the C drive named tests.xml and you have defined a SUT in PETS with the
name SUT, then type the following command to run your package: Run_PETS.bat -run -package
"C:\tests.xml" -sut "SUT". Press <Enter> to begin execution.

5.2.2 Command line for automated tests

B Administrator: C\Windows\System3Z\emd exe

CLI for automated tests runs the tests in silent mode. It can be launched by following these steps:

1. Open a new command line window as an administrator.

~2. Navigate to Intel® PETS installation directory.

n b.1.76H11]
oft Corporation. ALl erights resevved.

(kBB IntelsIntel{R> Platform Enablement Te:

3. Type the following command to get usage: PETSCommandLine.exe -? Or PETSCommandLine.exe —help

5.2.2.1. The command line syntax for Intel® PETS executable

24

PETSCommandLine.exe [-? | -help] [-sutimport "SUT file path"] [-suts] [-sutsettings -sutselect "name of
sut"] [-sutinfo -sutselect "name of sut"] [-testconn -sutselect "name of sut"] [-testmeconn -sutselect "name
of sut"] [-getdeepsx -sutselect "name of sut"] [-package "package file path" -tests] [-package "package file
path" -teststeps "test name"] [-package "package file path" -tests -sutselect "name of sut" -run] [-package
"package file path" -sutselect "name of sut" -runtest "test name"] [-package "package file path" -sutselect
"name of sut" -testcase "test name" -runsubtest "sub test name"][-repeat “number of times to run the test"] [-
failurebehavior “behavior when test fail"] [-htmllog] [-spreadsheet]
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The following table explains the command line options:

Option

-?/-help

-sutimport
-suts

-sutsettings

-sutinfo

-testconn

-testmeconn

-getdeepsx

-tests("

-teststeps'"

-run®

-runtest”

-runsubtest”

-repeat!”

-failurebehavior M ®?

Intel Confidential

Description

Displays all the arguments supported in PETS CLI.

Imports any SUT file to Intel® PETS.

Displays all SUTs in the DefaultSut.xml file.

Displays SUT information, platform version, type, SKU and
network, Intel® ME FW version, Power, Intel® APS settings,

and features that are enabled.

Retrieves the following information about the SUT:

Firmware, MEBx, LMS, BIOS, MEI Driver, GFX Driver, LAN

Driver Versions, and Configuration State.

Tests the connectivity with Local Agent, that includes:

1. Ping Local Agent.
2. Verify communication with Local Agent.
3. Local agent version matches to PETS version.

Tests Intel® ME connectivity.

Gets the DeepSx configuration from BIOS and saves the

setting in DefaultSut.xml.

Prints all test within the selected package.

Prints all test steps within a test in the selected package.

Runs all tests within the selected package.

Runs the selected test.

Runs the selected subtest.

Runs the selected Package/Test/Subtest more than 1 time

(depends on user decision).

Decides the behavior upon failure of a subtest, a test, a

package.

How to use?

-? Or -help

-sutimport "SUT file path"
-suts

-sutsettings -sutselect "SUT Name"

-sutinfo -sutselect "SUT Name"

-testconn -sutselect "SUT Name"

-testmeconn -sutselect "SUT Name"

-getdeepsx -sutselect "SUT Name"

-package "Path\PackageName.xml" -tests

-package "Path\PackageName.xml" -teststeps "Test
Name"

-package "Path\PackageName.xml" -sutselect "SUT
Name" -run

-package "Path\PackageName.xml" -sutselect "SUT
Name" -runtest "Test Name"

-package "Path\PackageName.xml" -sutselect "SUT
Name" -testcase "Test Name" -runsubtest "SubTest
Name"

1.  -package "Path\PackageName.xml" -sutselect
"SUT Name" -run -repeat 2

2. -package "Path\PackageName.xml" -sutselect
"SUT Name" -runtest "Test Name" -repeat 2

3. -package "Path\PackageName.xml" -sutselect
"SUT Name" -testcase "Test Name" -runsubtest
"SubTest Name" -repeat 2

1. -package "Path\PackageName.xml" -sutselect
"SUT Name" -run -failurebehavior "NextTest"
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Descripti How to use?
2. -package "Path\PackageName.xml" -sutselect
"SUT Name" -runtest "Test Name" -
failurebehavior "NextSubTest"
3. -package "Path\PackageName.xml" -sutselect
"SUT Name" -testcase "Test Name" -runsubtest
"SubTest Name" -failurebehavior "NextStep"

- htmllog M®®@ Creates the HTML log for the running Package/Test/Subtest. ~ -package "Path\PackageName.xml" -sutselect "SUT
Name" -run -htmllog -logspath "Path\LogFolder"

-spreadsheet ()4 Create the spreadsheet for the running Package/ Test/ -package "Path\PackageName.xml" -sutselect "SUT
Subtest. Name" -run -spreadsheet -logspath "Path\
LogFolder"

™ If Path was not provided as "Path\PackageName.xml", write only "PackageName.xml" the path will be the default folder as
defined in SUT, example: ME\CNL\Windows\Consumer\Mobile\Wired_Only

@ - Failure behaviors supported for running package are: NextStep, NextSubTest, Nextlteration, NextTest, Stop
- Failure behaviors supported for running subtest are: NextStep, Nextlteration, Stop
- Failure behaviors supported for running test are: NextStep, NextSubTest, Nextlteration, Stop

®  -htmllog and —spreadsheet commands can be used together

@ If the path was not provided as "Path\LogFolder”, the logs will be saved in “PETS root\Logs\Log_XMLs"

5.2.2.2. Exit Codes

CLI returns 3 exit codes as follows:
=  0: Test passed/command succeeded
=  1:Test Failed
=  -1:Error occurred

5.3 Defining the Intel® System Under Test

An Intel® SUT is an Intel platform that was defined for testing by the Intel® Platform Enablement Test Suite.
In order to run a test package:

e An Intel’ ME or TXE platform must be defined as a SUT in the Systems Under Test dialog.

e A SUT must be selected for testing from the drop-down list of SUTs in the Intel® Platform Enablement
Test Suite window’s toolbar's Platform field (=),

You can only test one SUT at a time even if more than one SUT has been defined or imported for testing. The
Platform field displays the name of the SUT being tested. All the SUTs that are available for testing by Intel®
Platform Enablement Test Suite are listed in the Platform field's drop-down list. If the Platform field is empty,
a SUT has not yet been defined or imported for testing.

If the wrong SUT is displayed in the Platform field, you can select a different SUT from the Platform field's
drop-down list. If the correct SUT is not listed there, you can use the Systems Under Test dialog to add or
import the correct SUT. The names of all the SUTSs that have been defined or imported for testing in the Intel®
Platform Enablement Test Suite are saved in the default SUT file (defaultSut.xml).

5.4 Systems Under Test Dialog

You can open the Systems Under Test dialog in the following ways:
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e Select SUT Management from the drop-down list in the Platform field.

e Choose Settings > Systems Under Test.

e Click the Platform button (E ) in the toolbar.

The Systems Under Test dialog has up to seven tabs. Each tab defines a different set of parameters:
e SUT Overview - general data about SUT; Systems Under Test dialog opens to this tab by default.

¢ Intel® ME Settings - authentication data, IP and ability to enable and disable some logging features for
Intel® ME.

e General Host Settings - contains the information used by the Intel® Platform Enablement Test Suite to
connect to the local agent on the SUT.

e PETS Automated Power Provider - selects and configures the SUT's power provider.
e Power Settings - power settings of the SUT.

e System Information - displays the SUT’s ME (or TXE) Information.

You can do the following in the Systems Under Test dialog:
e Add anew SUT to the Intel® Platform Enablement Test Suite and define its parameters.
e Select an already-defined SUT.
e Import an existing SUT definitions file.
* Redefine the parameters of an already-defined SUT.
e Delete a SUT from Intel® Platform Enablement Test Suite.
e Export the SUT definitions to a file.

e Check if the Intel® Platform Enablement Test Suite is properly connected to the SUT.
5.4.1Adding and Defining a SUT

To add a SUT and define its security settings:
1.  Open the Systems Under Test dialog. The Systems Under Test wizard opens.

2. Click the New button; a dialog prompts you to choose the type of SUT that you are defining. Select the
SUT type you want (ME, TXE, or Simple) and click OK.

Choose SUT type @

Flease choose the SUT type:

[ ME [Manageability Engine]

QK
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3. The SUT Creation Wizard opens to the Description tab.

B SUT Creation Wizard

SUT Owverview

Hame

De=scription

Platform Version
Platform SKL

Platform Type
Manageability Inteface

Dperating System

CSE15.4 ElkhartLake
CSME135 Jaspailake
CESME1S TigerLake
CSMEN4.5 Comellake
CEMET4 Cometlake
CSEME13 lcelake
CSME12 WhiskeyLake
CSME12 Cannonlake

CSME2 Coffeelake
VIO

(o) ()

The SUT Creation Wizard "New" screen shows minor differences, depending on the SUT type that you
previously selected in step #2. The figure above shows the configuration fields for an Intel® ME platform; the
figure below shows the configuration fields for an Intel® TXE tablet platform. The next figure shows the
configuration fields for simple SUT platforms. Throughout the SUT definition process, the configuration fields
provided on each screen: SUT Overview, General Host Settings and Intel® PETS Automated Power Provider

will vary according to the SUT type you choose.

SUT Creation Wizard
SUT Overview
Description | |
Platform Version: | APL v |
Platform Type: |Mobile v|
Manageability Interface: |Wired Only v|
Operating System |Wind0ws v |
( < Back ) ( Next ) ( Cancel )

28
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ﬁsm Creation Wizard ' Ef! J
Simple Sut Configuration (No FW)
Name
Description
User Name 0
Password
IPv4 Address QLomI sSuT
MAC address ( Retrieve |
|
Port Mumber: 12000 |
[ Test connectivity with Local Agent ]
[ Test Environment .i < Back ::. |:J Finish ] |: Cancel \]
- )
Note: Simple SUT is appropriate when you want to work with a SUT regardless of its firmware, for example, if your

tests are not related to a specific firmware feature. Simple SUT is a one-step wizard that only asks for
operating system information.

4. Enter data about the SUT into the following fields:
— Name
— Description
— Platform Version
— Platform SKU: Select Corporate (used to be called 5MB) or Consumer (used to be called 1.5MB),

— Platform Type: Select Desktop, Mobile or Server/Workstation system for Intel® ME platforms;
Mobile or desktop for Intel® TXE platforms.

— Manageability Interface: Select Wired Only, Wireless Only, Wired and Wireless for Intel® ME
platforms; Wired Only or Wireless Only for Intel® TXE platforms.

— Operating System: Windows* is selected by default. This setting It is the only relevant OS that is
currently supported for Intel® ME and TXE platforms.

5. Click Next; the following General Host Settings dialog appears:
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SUT Creation Wizard

General Host Settings

User Noe =
Password

LAN IPv4 Address (i)

MAC address | ( Retrieve )

WLAN IPv4 Address (1)

MAC address

I Part Mumber: 12000 (i}

| Test connectivity with Local Agent |

[] Test Environment . ( < Back )( Next )( Cancel )

If the system has wired and wireless network connection, the following General Host Settings dialog appears:

& 5UT Creation Wizard ®
General Host Settings
User Name [______Jo
Password
LAN [Pv4 Address e
MAC Address | Remeve
WLAN [Pv4 Address - e
Port Number: E .
Test connectivity with Local Agent
L] Test Envranment ( <gss | met ([ conca |

30
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6. Enter data into the following fields:
— User Name: OS user name.

— Password: OS password.

Note: Replace the password with dots in OS and Intel® CSME credentials pages to prevent un-authorized access to
information through keyboard cashes and shared dictionaries

— LAN IPv4 (WLAN IPV4): IP address of the SUT'’s operating system.

— Port Number: The port that the local agent listens on. If this port is used by another application, you
need to change the port number. To change the local agent's port number, open the
PETSlocalagnet.exe.config file in the installation directory and change the address field so it
contains the new port number. For example, to change the port to 60000, change the address line
from <add key="address" value="net.tcp://localhost:12000" />
to <add key="address" value="net.tcp://localhost:60000" />
The default port for Windows* is 12000 and for Android* it is 6500.

— LAN MAC address (WLAN MAC address): LAN card MAC address for magic packet; either enter
manually or press Retrieve.

— Test connectivity with Local agent: Clicking this option verifies whether the Intel® Platform
Enablement Test Suite is able to connect with the PETS local agent on the SUT host and displays a
dialog of Local Agent Connectivity Results. When verification is performed on a Wired and Wireless
LAN Test package, an additional entry appears for the Host WLAN connectivity.

Local Agent Connectivity Results E

Ping Local Agent Host - LAN

Ping Local Agent Host - WLAN

Verify communication with Local Agent

Local Agent version matches to PETS version

— Test Environment: If checked, on each screen in the SUT wizard flow where these is a test button,
the test will be run before the Next button flow is executed. If unchecked, at the end of the wizard
flow, the System Information tab will not be updated with data, until Refresh is pressed.
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Note: The example screens shown in the following steps are for an ME test platform.
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7. Ifyour SUT is a corporate system, click Next; the Intel® ME Settings dialog will appear. If the SUT is a
consumer system, continue with step 12.

Systems Under Test X

(ven ) (mpon ) (_2mon )

V‘ ( Delete )

Inelo M Setings | PaiiSaiIEN |
User Name 0

WLAN |Pv4 Address 192,168,122 (i)

(Tocomeam )

TCP Data Retransmission in Seconds l:l

- &

If the system is connected through wireless only network interface, the following Intel® ME Settings
dialog appears:

Systems Under Test X

(Cren ) Cimpor ) (epon

V| ( Delete )

WLAN |Pvd Address 192.168.1.22 (i)

a
TCP Data Retransmigsion in Seconds l:l
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8. Enter the Intel® ME Settings in the fields provided:

— Digest Authentication (AMT/ME login): Enter the user name and password of an Intel® AMT user on
the SUT who is the default Admin user or another user that has Administrator rights on that system.
(These rights are set via the Web Ul or the Intel Setup and Configuration Service.)

e This should be the user name and password of the Intel® AMT FW running on the Intel®
ME, not the Host OS.

e The Intel® AMT/ME password can be added during the initial MEBx (CTRL+P) session
during the boot sequence.

e The password must be changed after burning Intel FW or clearing CMOS.
— LAN IPv4 (or WLAN IPv4) address of the ME:

e If the platform uses a static IP address, enter the IP address of the ME as defined in the
MEBx.

Note: Don't use the same static IP address for both Host OS and ME on the SUT.

e If the platform has a dynamic IP address, enter the IP address provided for the platform
by the DHCP server.

— Click Test ME connectivity to check the ME connection.

9. Click Test ME connectivity to PETS local agent to check whether Intel® Platform Enablement Test Suite
connects with the PETS local agent on the SUT host.

10. If you are defining a corporate Wired and Wireless system, the following Intel® ME Settings dialog
appears. For all other systems, continue with step 12.

Systems Under Test *

( new )( import ) Bpot |

CML-WLAN
S LR | 'niete ME Seting: | S

User Name 0

WLAN IPv4 Address 192.168.1.22 (1]

( Test Connectivity |4
TCP Data Retransmission in Seconds
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11. Enter the ME Wireless information in the fields provided.
— WLAN IPV4 Address.

— TCP data retransmission in seconds: minimum (default) value is 5 and maximum value is 7.

— Tests affected by this new feature are AMT_013, AMT_031, AMT_033, AMT_035-
038, AMT_041, AMT_043, AMT_045, AMT_047, AMT_049-058, AMT_082-083, and AMT_085

12. Click Test Connectivity to check whether Intel® Platform Enablement Test Suite connects with the
wireless ME.

13. Click Next:

— If you are defining a desktop client platform (or workstation), the following dialog appears.

SUT Creation Wizard
Power Settings
(@) Deep Sx
Deep 54/55 policy DISABLED -3
|:| Test Environment [\ < Back )] [\ Mext )] [\ Cancel )]

— If you're defining an Intel® CSME 12.0 desktop client platform, the following dialaog apears

Note: When choosing the option “Don't distinguish between S4 and S5”, the system states S5/DS5 will be ignored
on power off.
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Power Settings

(@) Deep Sx

Deep 54/55 policy | DISABLED

v|a

() 505 wel Dawn

SUS Well Down Disabled {system stays in 54/55)
® SUS Well Down Enabled (system moves to G3)

55 only
® S4and 55

[] pon't distinguish between 54 and 55

I:‘TestEnvironment ( < Back :]( Mext )( Cancel )

— If you are defining a mobile client platform, the following dialog appears.

% SUT Creation Wizard

Power Settings

@ Deep Sx

Deep 54/55 policy

)

O sUs well Down

SUS Well Down Disabled (system stays in 54/55)
5US Well Down Enabled (system moves to G3)

55 only
54 and 55

[] por't distinguish between 54 and 55

[] Test Environment ( < Back ) ( Mext ) ( Cancel

— If you're defining a TXE mobile client platform, the following dialog appears:
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Note: When choosing the option “The platform is configured to go into a lower power S4/S5
state (G3) with DC only source.”, PETS will expect for hibernate either G3 or S4, and for power off either
G3 or S5.

& SUT Creation Wizard X

Power Settings

H The platform is configured to go into a lower
power 54/55 state (G3) with DC only source.

DTestEn'uirnnment t: < Back )( Mext )( Cancel )
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In the Power Settings dialog, select the appropriate options to configure the SUT's power provider. The
fields can be understood as follows:

For Desktop or Workstation platforms:

— Check if Deep Sx is enabled, and then click the Retrieve Deep Sx button placed next to the Deep Sx
policy drop down menu. This feature retrieves the Deep Sx settings from BIOS and then sets the same
value for the SUT Deep Sx settings.

For mobile platforms:

— Check the following radio button in case your platform doesn't support DeepSX and SUSwelldown
. This option is only applicable for Mobile and Mobile-H platforms.

() sUs well Down and Deep Sx Disabled

— Check the radio button to define if Deep Sx is enabled, or if SUS Well Down mode behavior is defined
instead.

— If Deep Sx is enabled, select the Deep Sx policy from the combo

(@) Deep Sx
Deep 54/55 policy | DISABLED vl =

| Get DeepSx configuration from SUTs bios l

— Deep Sx Retrieve button placed next to the Deep Sx policy drop down menu. This feature retrieves
the Deep Sx settings from BIOS and then sets the same value for the SUT Deep S4/S5 policy settings.

— If Suspend mode behavior is defined, select the SUS Well Down mode behavior of your system. You
can select one of the following:
e SUS Well Down Disabled (system stays in S4/S5)

e  SUS Well Down Enabled (system moves to G3). If you select this option, you must also select
the radio buttons to define if this behavior is in DC only, or in ACDC as well. Also, select the
radio buttons to define if this behavior is in S5 only, or both S4 and S5.

14. Click Next; The System Information prompt appears.

SUT Creation Wizard “

System Information

I
Press Refrieve to refrieve Sut information [' Retrieve I
|:| Test Environment t < Back ) ( MNext ) ( Cancel )
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— Click “Retrieve” to obtain the system information . This step is not mandatory since PETS will
automatically retrieve the information upon closing the SUT wizard and the button will change to
“Refresh”.

“Systems nder Tes - e

(_dew ) ( tmpon | ( Epon )

|CML_wian_corp »|  ( Detete |

Systomintommotin | FETS P Proide__ Feo Sl

SUT Information Redfrast

Flrmware Version: 14.0.20.7214 H Corporale
Configuration State: PostProvisioning

FODH: b

MEBx Version: 14.0.0.0001

LMS Version: 1932 14.0,1331

ME] Driver Version: 19191401269

BIOS Version: CMLSFWR1.RD0.1272. D00, 1907030638
EC FP\W Version: 81.0

035 Edition: MicrosoRt Windows 10 Pro

08 Version: 10.0.18362

GFX Driver Version: 21.21.13.7892

GFX Driver Description: NVIDIA GeForce GT 710
WLAN Drver Version: 21.40.0.1

15. Click Next; PETS Power Provider dialog appears.
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Systems Under Test X

( Delste |

| SUTOveiew  GeneolHostSelings  IWeloMESeiings o Selings
L Sysenifmaion || PETS PowerProviks ||| FeeSekeion. | |

® Manual

O Intel® APS 3
() TTK2 Device Enable PETS Power Provider Tracing

Refresh Frequency: |0.25 seconds
Delays Settings:

Clear Cmos Delay After First G3 10 seconds
Clear Cmos Delay After Second G3 10 seconds
Short Reset Delay 0.5 seconds
Short Power Button Delay 0.5 seconds
Power Button Ovenide Delay:

Defautt Power Button Cveride Delay 10
Set Power Button Ovenide Delay 10.001

Mote that power packages are not designed to be run in this mode

In the PETS Power Provider dialog, select the chosen Power Provider (Manual, Intel APS 3 or TTK2
Device), then select the appropriate options to configure the Delays Settings. The filed can be
understood as follows:

— Enable PETS Automated Power Provider Tracing:

When selected, PETS starts logging every change to Automated Power Switch (e.g. system
power state / ME state / Power source). The changes are included in the test's execution
report.

— Refresh Frequency:

This field is enabled when the user checks the "Enable PETS Power Provider Tracing"
option and specifies the time period in which PETS will check for Automated Power Switch
changes.

— Delays Settings:

Short Reset Delay: defines how long the delay takes to perform a Reset (in seconds).

Short Power Button Delay: defines how long the delay takes to perform a power button (in
seconds).

Power Button Override Delay:

o Default Power Button Override Delay: if it is selected, the power button
override delay (in secs) will be the default value (APS default value) which is 10.

o  Set Power Button Override Delay: if it is selected, the power button override delay will
be the value that the user enters (in seconds).
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16. Click Next; The feature selection dialog appears. In this dialog, select the feature(s) that are enabled on
the SUT.

= SUT Creation Wizard E

Feature Selection

Select the features which are enabled on the SUT:

[1 50 Low Power Idle State (S0ix)
DC-only Power State

Intel® AMT KVM Support

Intel® AMT SOL Support

Wake on LAN (Wol)

[1 wake on Wireless LAM (WoWLAN)

Note: When S0 Low Power Idle State (S0ix) is selected,
S3 related test tems are automatically removed.

I:‘TestEnvironment ( < Back \)( Finish )( Cancel )

Features that are not selected cause the relevant tests/sub-tests/test steps to be hidden. Please note that the
feature selection options that appear in this dialog depend on the platform version, SKU and type defined
previously. For example, features that depend on the platform version are listed below:

e SOix is supported in Intel® ME 12 and onwards.
e WolL and WoWIlan are supported in Intel® ME 12 and onwards
e DC, KVM, and SOL are supported in Intel® ME 12

Note: When SO Low Power Idle State (SOix) feature is selected, S3 related test items are automatically removed.
Note: Pointing the mouse icon at any feature displays a tooltip with a brief description of the selected feature.

17. Click Finish; the following information screen appears providing current ME information for the newly
defined SUT.
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Systemns Under Test

Descriplion

Flatform Version

Plalform SKL

Platf orm Type

Manageability bl el ace

Operating System

CFL-Corporate

CSME12 Coffeslake
Corporate

Mabile

Wired Only

Windows

The information entered into the dialog only becomes active after being saved.

18. Click the Save button to save the information entered to the SUT dialog into the Platform information

19. Click the Close button; the “Saving System Information” dialog appears indicating the PETS is trying to
save the SUT information that it just retrieved from the SUT.
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( Mew ) ( import | ( Expor |

(CFL v/ ( Delete )

| SUTDwviw  GewsHoaSetigs IO NESeigs  PoweSeings
Systeninlomatin TS o Proda Fedu Sketin

Press Retrieve to retrieve Sutinformation | ( Retteve |

System Information

Saving System Information

the SUT dialog closes and the system prompts you to run the Intel® Platform Enablement Test Suite.

- : 3
Run ﬂ'leif_:mp Environment Test ' .

To ensure that Intel® Platform Enablement Test Suite can fully work with this SUT,
please ensure to run the Setup Environmert Test package

-

20. Click OK; Run the setup prompt disappears and the Wizard closes.

21. Run the setup test package to check if the SUT was configured correctly. (For more details, see "Testing

the Configuration of the SUT"))
5.4.2Selecting a Previously-Defined SUT

The SUTs that are listed in the drop-down list of SUTs at the top of the Systems Under Test dialog have
already been defined.

To select an already-defined SUT:

Select one of the SUTS listed in the drop-down list of SUTS; the values of the parameters of the selected
SUT appear in the Systems Under Test dialog's fields, where they can be viewed and changed.

If you do not click the Save button before selecting another SUT, any changes you made to the definition of

the current SUT will be lost.
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5.4.3 Modifying the Definitions of a SUT
You can modify the contents of any field in any tab of the Systems Under Test dialog.

You cannot change any of the settings in the Description tab. If you need to change them, delete the SUT
and define a new SUT with the desired settings.

To modify an already-defined SUT:

1. Select the SUT you want to modify from the drop-down SUT list; the dialog’s fields and tabs are
populated with the selected SUT's data.

2. Make the relevant changes to the contents of the dialog’s fields.

3. Click Save.
5.4.4Saving the SUT Defined Parameters

After filling in all the relevant fields and tabs in the Systems Under Test dialog:
1. Click Save to apply all your changes.

2. Click Close to close the dialog; the names of all of the defined SUTs appear in the Platform field's drop-
down list in the Intel® Platform Enablement Test Suite window.

5.4.5Importing a SUT Definition File
1. Click on the Import button; the Import SUT file dialog appears.

2. Selecta SUT file and click Open; the imported SUT is listed in the SUT drop-down list and its definitions
appear in the Systems Under Test dialog's fields.

5.4.6Deleting a SUT from Intel® Platform Enablement Test Suite

To delete a SUT from the Intel® Platform Enablement Test Suite:
1. Select one of the SUTs listed in the drop-down SUT list.
2. Click the Delete button; then “Are you sure you want to delete this SUT" confirmation prompt appears.

3. Click Yes; the definitions of the deleted SUT disappear from the Systems Under Test dialog's fields.
5.4.7 Exporting SUT Definitions to a Definition File

To export SUT definitions:

1. Selecta SUT listed in the drop-down SUT list.

2. Click the Export button; the Save As dialog appears.

3. Enter the name of the definitions file into the File Name field and click Save.
4.

Intel® Platform Enablement Test Suite populates the definitions that you have entered into the Add New
SUT dialog.

5.5 Testing the SUT Configuration

The Setup Environment test package checks if the SUT was configured correctly. If the SUT passes all the tests
in this package, it is configured correctly and other test packages can be run on it. If the SUT fails a test, check
which test or test step fails in order to know how to reconfigure the SUT correctly.
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The setup Environment test package file name is “SetupEnvironmentTest.xml". Loading and running this test
package in Intel® Platform Enablement Test Suite Setup has the same procedure of loading and running any
other test package. (For more information, see "Configuring the Tests in the Test Pane" and "Configuring a Test

Package".)

Running the setup environment test package is optional but highly recommended to be run before running
other PETS general test packages.

5.5.1Testing the Configuration of the SUT

Test Name

Check Intel® AMT
Connectivity

Check Intel® AMT Feature
Support

Local agent and SUT
connectivity setup

Check S3

Check S4

Check S5

Check Deep S4

Check Deep S5

Compare Deep Sx
Configuration

Check DC Power

Check AC Power

Intel Confidential

The following table shows the tests included in the Setup Environment Test package:

Description Relevant to Platform

(Corporate/Consumer)

This test verifies the connectivity with the Intel® Corporate
AMT through either LAN-only, WLAN-only, or both
LAN and WLAN network interfaces.

This test verifies Intel® AMT feature configuration. Corporate

The test checks connectivity between the console  Both
and the local agent (SUT) through:

1. Verifying PETS agent version.
2. Retrieving ME information from PETS agent.

This test checks the SUT power flow from SO/CMO  Both
to S3/CM3 to SO/CMO via Host OS suspend cycle.

This test checks the SUT power flow from SO/CMO  Both
to S4/CM3 to SO/CMO via Host OS hibernate cycle.

This test checks the SUT power flow from SO/CMO  Both
to S5/CM3 to SO/CMO via Host OS shutdown cycle.

This test checks the SUT power flow from SO/CMO  Both
to S4/CM-Off to SO/CMO via Host OS hibernate
cycle.

This test checks the SUT power flow from SO/CMO  Both
to S5/CM-Off to SO/CMO via Host OS shutdown
cycle.

This test compares Deep Sx configuration in PETS  Both
with BIOS to avoid a mismatched configuration.

This test checks the SUT power flow from AC and Both
DC to DC-only.
*(Mobile platforms only)

This test checks the SUT power flow from AC and Both
DC to AC-only.
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Test Name

Check G3 State

OS Configuration checks

InstantGo configuration
match

46

Description

This test checks the SUT power flow from SO/CMO
to G3/CM-Off via Power loss.

Verifies both OSs on the console and the local
agent are supported by Intel® PETS.

Verifies if SO low-power idle setting in PETS SUT
configuration matches the SUT configurations.

intel)

Relevant to Platform
(Corporate/Consumer)

Both

Both
Both

*(InstantGo supported
platforms only)
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6 Running Tests with Intel® Platform
Enablement Test Suite

This chapter describes how to use the Intel® Platform Enablement Test Suite to run tests on an SUT. The
following topics are included:

Configuring a Test Package

Viewing PETS Automated Power Provider Controls

Running Tests

Viewing, Saving, and Sending Test Reports

Using the Compliancy Guide

6.1 Configuring a Test Package

The Intel® Platform Enablement Test Suite is supplied with one or more test packages. Each test package
contains the XML files that define its tests. All test packages must be loaded into Intel® Platform Enablement
Test Suite. Each test package - including its tests and test steps - are already configured with default values
that can be changed in the Intel® Platform Enablement Test Suite.

Different platforms require different test packages.

6.1.1Loading a Test Package

Intel® PETS is able to open the correct packages' sub-folder based on the SUT settings.

1.

Choose Package > Open; the Open Intel® PETS Package dialog appears, displaying the contents of the
folder <Intel® Platform Enablement Test Suite folder>\Packages> depending on the SUT
configurations.

Select the test package that is appropriate for the SUT. The name of the selected test package and the
number of tests it contains appear in the Intel’ Platform Enablement Test Suite window above a list of
tests in the package.

The package's test names map directly to tests that are listed in your Intel® AMT platform’s Compliancy
Requirements and Testing Guide, which contains a detailed description of each test (with the exception of
the Validation package tests, which do not appear in the Guide). Each Test Name maps to the test ID of a
test in the Compliancy Requirements and Testing Guide.

If Supports SO Low Power Idle option in the SUT Configuration under Power Settings is set, and the loaded
package contains tests, sub tests or test steps related to S3, a message appears to inform the user that
these tests will be hidden.
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Some tests [ steps were hidden from the package since they are not applicable for the

current SUT.

6.1.2 Opening a Recent Package
The Intel® Platform Enablement Test Suite allows you to select a package from a list of the 10 most recently
opened packages.

1. Choose Package > Recent Packages; a list of the 10 most recently opened packages appears.

Intel(R) Platform Enablement Test Suite

Tools  Hel)

Pacl View  Settings  Run
Open... Ctrl+0

Report

| Recent Packages ME\CML\Windows\Corporate\MobiletWired_And_Wireless\Compliance ISHxml
Save As... F12 .MBE\CML\Windows\Corporate\Mobile\Wired_And_Wireless\Compliance_ME_Power_Gating_MNetwork_Wakexml
Save Ctrl+S MEVCML\Windows\Corporate\Mobile\Wired_And_Wireless\Compliance_Power_G3-50xml
New Ctrl+N MEVCMLYWindows\Corporate\Mobile\Wired_And_Wireless\Compliance_ME_Power_Gating_Provisionaml
Edit WMEVCMLWindowsh\Corporate\Mobile\Wired_And_Wireless\Compliance AMT.xml AT
Run Multiple ME\CML\Windows\Corporate\Mobile\Wired_And_Wireless\SetupEnvironmentTest.xml Running
Find Test Case... Ctrl+F
3, Testworst case system interference and effect on sensar algorit Inherit e MotRunning
Pack P eters...
S Alsale 3] Test gystern performance and effective calibration under a specr Inherit e MotRunning
Exit !, Barometer (pressure) sensor sanity test Inherit ~ MotRunning
B |155_TeT 0@ 2, Light sensor (ALS) accuracy test Inherit ~ MatRunning
[} 1S5_TST_10 !, Light sensor (8LS) angular response test Inherit ~ MotRunning
B | 185_TeT_11 ], 360 Hinge accuracy test with 2nd Accelerometer Inherit ~ MatRunning

Run | Test Step Mame Description Params | Failure Behavior | Status
1 B BringToBaseState Bring the SUT to the hase state of S0Medn, and confirm that the Host O Inherit w MotRunning
2 B | verityPlatiormDevices werify platform devices status from the device manager Inherit ~ MatRunning
3 B | PerformBist Ferfarm BIST test level 0 Inherit w MotRunning
4 B4 | PerformBist Ferformm BIST test level 1 Inherit 2 MotRunning
5 B | PerformBist Perfarm BIST test level 2 Inherit ~ HotRunning
6 B4 | Performpist Ferform BIST test level 3 Inherit v MotRunning

2. Select the package you wish to open from the list.

6.1.3 Finding a Test Case

The Intel® Platform Enablement Test Suite enables the user to search for a Test Case, in case the user
doesn’t know in which package the test case exists.
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1. Choose Package > Find Test Case; The Find Test Case dialog will be displayed.

Intel(R) Platform Enablement Test Suite

|.,Package L View Settings Run Report Tools Help

Open... Ctrl+0O

Recent Packages

Save As... F12

Save Ctrl+5

New Ctrl+N l  Description
Edit =

Run Multiple

Find Test Case.. Cti+F |

Package Parameters...

Exit

2. Type any Test Case name in search text box, the Grid will be filtered and will only show the packages
that have that Test Case:

Find Test Case = O x

(o1 =il T ] oS C: \PETSCode \pets\ComplianceToolGui\Compliance Tool \bin\Debug Packages WE\CFL \Windows \Corporate \Des
Test Case : AMT_002

é odified
Compliance _AMT xmi 2/6/2020 3:02:07 PM

3. The user can change the Default SUT xml packages Directory and browse for another directory that has
a valid xml packages, PETS will show the selected folder and sub folders packages.
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t Case - O K

Search ...

C: \PETSCode\petsComplianceToolGuilComplianceTool\bin\DebugiPackages WMECFL \Windows\Corporate \Desktop\Wireless_O

ITxml | Browse For Folder
atGuard xml

Lxml

*_Haxml
=l{R)_Authenticate xml
Bios xml

W ~
Bios_ManufacturingMode xml CrL
‘Common Services xml v Windows

:_Power_Gating xml 3 Consumer
:_Power_Gating_Network_Wake 1

:_Power_Gating_Provision xml
wer_G3-50xml v Desktop

wer_G3-552ml . .

wer G255 WoWLAN Wired_And_Wireless
wer_Network_Wake xml Wired_Only
wer_RSTaml Wireless_Only
Sxml .

Taml > Mabile
FlashConfiguration xml > Mobile-H

ting xml are

ting_WolWLAMN xml
= Make News Folder | oK | | Cancel |

v Corporate

4. If the selected directory doesn't contain any xml packages, a message appears to the user 'This directory
does NOT contain any XML Packages'.

5. Double click on the package name or select the package.

6. Click the select button then the package will be loaded to PETS GUI.

6.1.4Using the Intel® Platform Enablement Test Suite Window

The Intel® Platform Enablement Test Suite displays the tests in the loaded test package by default.

[ intel(R) Platfcern Enablement Test Suite
Package Wiew Settngt Run  Fepot  Tools

[v] Run | Tist Hame Dhescription | Repiat| Faddure Behamo Stalus

1 E AMT_00 L Syaterm Management BICS (SMBIOS) Tabls Gensration 1 _Irlhlﬂ _:! MoiRumning
B | aaT L Aarl Slandar Formal (A5F Tahle Caneration { ||"|||'ﬂ :! S
3 B | aar_oio inharit :-! "
+ | B |w o whert |
o Inheet :!
B s ona bt |
2 | I
8 =T HeadSubTest |
B | NessunTest |
EA | auT i Infyaet | NN
2 | @ | mnent |
A

The Intel® Platform Enablement Test Suite displays the following information about each test/test step:
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e Test Name: Name of the test/test step as it appears in the relevant Compliancy Requirements and
Testing Guide

e Description: Description of the test/test step's functionality. The icon next to the description shows what
is being tested and how:

(0]

o

%} - Setup test — A test that configures the SUT in preparation for an upcoming test.

- A test with manual steps.

¢ Repeat: Number of cycles of test repetition before the next test in the package is to be run (tests only).

¢ Failure Behavior: How Intel® Platform Enablement Test Suite responds to the failure of a test package,
test, or test step:

(0]

Next step - If a test step fails, Intel® Platform Enablement Test Suite runs the following step in the
test.

Next iteration - If a test fails, Intel® Platform Enablement Test Suite runs the next iteration of the
same test. If the last iteration of the test that fails, Intel® Platform Enablement Test Suite runs the
next test.

Next test - If a test or test step fails, Intel® Platform Enablement Test Suite runs the next test instead
of continuing to run any more of the failed test's test steps or iterations (This is the default failure
behavior option for test packages).

Stop - If a test or test step fails, Intel® Platform Enablement Test Suite stops running that test
package.

Inherit - Inherits the failure behavior of the level above (i.e., a test inherits the failure behavior of its
test package and a test step inherits the failure behavior of its test).

Next Subtest - If one of the test steps failed and there exists other subtests in the test, the next
subtest is executed.

Manual - Upon failure, choosing this failure behavior will allow the user to control the
failure/recovery process by showing the following dialog:
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@j Test Case [Local agent and SUT connectivity setup] failed an the following step (in Red), please choose

| D Step Mame Description Status

1 Message Display a message tothe user Ciane
2 | Localdgenty.. | Check local agent connectivity and version consist.. In Progress

3 | LocalAgenth.. Read ME infomation using the local agent MotRunning

The example screen shows the failing test step highlighted in red, and the test steps
above and below it as well. The user can choose one of the following options:

Retry: This lets PETS re-run the failing step before proceeding to the next one. If the test step passes
after retrial, the status will be then passed with warning. Refer to the "Status" section below for more
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details. The success details are added to the PETS Log. The PETS log details all step events, displaying
the status of each retry as shown below.

(39 ) GBE PCle* Port Select

@ NewSpiFlash TBReadFromSPIFlashiMemory
(40 ) PCH Descriptor Record 55

@ NewSpiFlash TBAddOffsetToRegister
(41 ) LAN PHY Power Control GPD11 Signal Configuration

@ NewSpiFlash. TBReadFromSPIFlashMemory
(42 ) LAN PHY Power Control GPD1 Signal Configuration

@ NewSpiFlash. TBGetBitField
(43 ) LAN PHY Power Control GPD11 Signal Configuration

@ PSS ntelintegratedWiredLanCheck

(44 ) Check if using Integrated Wired LAN solution

@ PSS ntelintegratedWiredLanCheck
(44 ) Check if using Integrated Wired LAN solutiont Retry 1

@ PSS IntelintegratedWiredLanCheck
(44 ) Check ifusing Integrated Wired LAN solutionf- Retry 2

A
(44 )Checkifusing Integrated Wired LAN solution}- Retry 3

Report name: Compliance_PSS5_2015.01.04_11.30.45 L

e Continue to and select one of the following options:
o Next Step - The current step is marked as passed with a warning, and the next test step is executed.

o Next Iteration - The current step is marked as passed with a warning, and the next test iteration is
executed.

o Next Test - The current step is marked as passed with a warning, and the next test is executed.

o Next Subtest - The current step is marked as passed with a warning, and the next subtest is
executed.
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e Stop: This will stop the execution of the current test and will run the next test or stop execution if it is
the last test in the package.

e Status:

o Not Running - The test has not yet been run.

o ’ Iteration indicator - The test is currently running that iteration(e.g., 1/3).

o - Passed - The test was run successfully.

o 9 Failed - The test was run unsuccessfully.

o @ Aborted - The testing process was aborted by the operator.

o  FauEed paused - The testing process was paused by the operator
& . . . . . .
o Passed with warnings - This status appears along with the "Manual" failure behavior when the

test step is failed, retried or continued by the user.

o " Failed with warnings - This status appears for optional test steps, for example, CheckFWSTS.

6.1.4.1 Viewing a Test’'s Steps

To view a test's steps:
1. Choose View > Steps Pane; the Intel® Platform Enablement Test Suite window is divided into two panes:

o Upper pane - the Test pane - lists all the tests in the test package. Each test has Run, Failure
Behavior and Repeat options that configure how that test is run.

o Lower pane - the Test Step pane - lists all the steps in the test selected in the Test pane (the first test
is selected by default). Each test step has Run and Failure Behavior options that configure how it is
run.

2. Click on one of the tests listed in the Test pane; the test steps of the selected test are displayed in the
lower pane.
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Intel(R) Platform Enablement Test Suite

D [Run | TestName

- oM

| Regea | Falrs Behavior | Status

@ | w00t
@ |amonz
@ |aron
@ | a0
@ |amos
@ |amo
@ o
@ |amoz
@ |amo
@ |ar_on
@ |amoa
2 | @ |aron
@ |03z
@ | w03
@ | a0
@ |aross
@ |mross
@ |amosr
@ | o
@ |mmoso
@ |amos
@ |aroez
@ |wiross

| Descrpton
et |v|  Notwuming
et V| vmuming
et |v| o
nent_ V| netrunning
et V|
et v
et v/
et v
et v|  voming
et V| vemuing
et |v|  Nouming
e v|  vomuming
% SeralOverLAN (S0L) and Storage Rediraction aver Intele AN |1 nert | v tetRunning
|3 seraroverLan @oLy a1 || mnent  |v|  NetRunning
. et v|  vomuming
et |
et v
et v
et |v|  vamuing
et |v|  Notmuming
et v|  vomuming
et |v|  vamuing
3 Keytoard, vidzo, ang Mouse 00 Redirecton over 1@ AT ([ 1 Inert || HetRunning

SingToBasestate

D [Run | Test Stap Name

verftesystemtate

Byetuorkc

| Description | Parars | Falure Sofavior | Status.
Wove he SUTo a Basesknown State hest v NotRuming
Ensure IDER Intortace s nent__|v|  NotRumning
hent v NotRumning
hert__|v|  NotRumning
et v o
SetUser Consant poley Nore hent v NotRumning
Set it BIOS Boct Osti 2 hert_ v,
y et v
hert_ | o
hert__|v|  NetRumning
et N 9
nhent NoRurring
UT ia ItelB AMT Using Pty hent v ot
et |

6.1.4.2 Configuring the Tests in the Test Pane

To configure the tests in the Test pane:

1. Verify that the checkbox in the Run column is selected for each test you want to run and deselected for
each test you do not want to run (The Run checkboxes are selected for all the tests by default). To select
or unselect all the tests, right-click the heading (Run) and choose Select All or Unselect All. Alternatively,
you can select/unselect multiple tests/test steps together.

2. To change the number of cycles that a test should be performed for, double-click the value in the test's
Repeat column and enter the number of cycles.

3. Click the help icon in the Params column to view and edit package parameters related to the test under
which the selected test step is nested.

4. Select one of the following options in the Failure Behavior drop-down list to define what will happen if
one of the test's test steps fails: Next step, Next test, Stop, and Inherit.

Note:

The “Failure Behavior” option provides simultaneous changeability of multiple selected tests.

W DR

Teil Mt
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B0
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1 Srvies ST VR (TR X %l e el
1 et TR 1N e AR 5 T e il

I Il Bt f vy AT Puaes Faer Tina (00T agaesd
1 ] A & reiry (Do) Phamlisees [oprd Trg (PET) Duppf w0
Reoip Frest [ erird as wiab U LK Fagbeors st s ba b

Eprae Fows {ormo we riadl AT WL Hadenr v e
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6.1.4.3 Configuring the Test Steps in the Test Step Pane

To configure the test steps in the Test Step pane:

1.

Verify that the checkbox in the Run column is selected for each test step you want to run and deselected
for each test step you do not want to run. To select or unselect all the tests, right-click the heading (Run)
and choose Select All or Unselect All, respectively. (By default, the Run checkboxes are selected for all of
the test steps.)

Select one of the following options in the Failure Behavior drop-down list to define what happens if a
test step fails: Next step, Next test, Stop, and Inherit.

Using Group Select/Unselect in Power Packages

For Power Packages only, Intel’ PETS groups steps into sub-tests, and allows an entire sub-test to be selected
or unselected. Simply right-click on a test and you will get the following screen (example shown):

Unselect Test Step

Select This Test Step And All Steps Below

Select This Test Step And All Steps Above
e Select All Test Steps

Unselect All Test Steps

Select All Automated SubTests
Report...
Preview

Display Description & Troubleshooter

You are also able to group select/unselect the relevant test steps with a single command.

Using the Right-click menu:

Open a test in Intel” PETS.
The steps in the Test Steps (lower) pane will be delineated by a horizontal line. The steps below the
horizontal line are the Sub Test steps. Right-clicking would open a menu with the following options:

1.

3.
4.

Select Sub Tests: To select all Sub test steps; alternatively, choose Unselect Sub Test to deselect all Sub
Test steps.

Select This Test Step And All Steps Below/Above: These options would select the current step and
mark either all above or below remaining test steps.

Unselect/Select All Test Steps: This will select or unselect all test steps in the current test.

Select All Automated Sub Tests: This will select only automated sub tests of a test.

Alternatively, users can use hotkeys such as shift or ctrl to select multiple tests. Users can mark the selected
test to be performed by right-clicking and choosing the Select Test Steps/s option from the menu.
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5. Preview: A preview dialog will display how the test step will look like when it is run. This usually appears
for test steps that display a message or question to the user as part of the execution.

Note: For now, this feature is only available for the Message and Question test steps. The below screenshot shows
an example of how the preview dialog would look like:

Message to be displayed: The SUT boot will be performed with a redirected IS0 0OS

image (without Serial-Over-LAN)

6. Display Description & Troubleshooter: This will activate a dialog that includes the following information:

— The name of test step and last date of modification of the test step’s description and troubleshooter.

— Description tab: This description is usually populated by Intel® PETS developers and reflects the
techniques and logic behind a specific test step and how it was programmed. As an example, when
activating this feature for the “BringToBaseState"” step, the user will get the following flow chart diagram
explaining the process of bringing the SUT to the SO state before running the test.

Intel® Platform Enablement Test Suite

Power.BringToBaseState Last Modified: 12/72016 9:14:51 AM

PECINGTIN Troubleshooting

This test step does the following:

= Brings the SUT to the base state of S0/MeOn

+ Confirms that the Host OS is available

« Confirms local agent is installed and service is started

+ For Corporate SUTs, BTS waits until Intels AMT on the SUT responds to version queries, checks LMS and sets link policy 2 if wireless only.

@ Move to 50

Go To Recovery (G3)
For local agent issues

[ pirgtos | S

— Troubleshooting tab: This tab contains debug information for the test operation in case of failures. Such
as the configurations which must be set in order to run the test step without failures. Here is an example
for the “BringtoBaseState” step Troubleshooter:

Intel® Platform Enablement Test Suite

Power.BringToBaseState Last Modified: 12/7/2016 9:14:51 AM

Troubleshooting

o If power provider is set to APS in PETS: Intel® APS must be installed, initialized and signals must be connected correctly to the SUT
+ PETS local agent must ba installed on SUT

* SUT user name, password and [P must be entered cormrectly in PETS console

« Intels AMT should be provisioned

 User name, password and IP of ME must be entered correctly in PETS

S G| G| ImetoME Sotings | s Saigl]
User Name: peksin o
Password Admniay Li]
LAN [Pyd Address haz 168,184 i}
(e )
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6.1.4.4 Configuring how a Test Package is run

To configure how the Test Package is run:

1. Go to Run>Failure Behavior and select which of the following options will occur if one of the tests in that
test package fails: Next iteration, Next test, and Stop.

2. Configure the Package Parameters of the test package. (For information on how to configure package
parameters, see Changing Package Parameters.

6.1.4.5 Saving the Changed Configuration of a Test Package
You can save the changed configuration of a test package as an original version or as a new version of that
package. Either one of the versions (original/modified) of the test package can be loaded into the Intel® Platform
Enablement Test Suite at a later date.
To save the changed configuration of a test package over the original version:

1. Go to Package > Save

El Intel(R) Platform Enablement Test Suite

Package | View  Settings FRun Repot T

Open... Ctrl+0

Recent Packages

Save As... F12

Save Ctrl+5 | ME_Power
Mew Ctrl+M

Edit :

Run Multiple

Find Test Case... Ctrl+F
Package Parameters...

Exit

Typically, you can use this function when editing an existing package and you wish to save changes as you work
(prevent loss of information if a crash occurs). Save replaces the original file.

To save the changed configuration of a test package as a new version:
1. Choose Package > Save As.
You can save the changed configuration of a test package as a new version basing the new
package on one you have already opened/edited. This is useful if you want to save an existing

package with a new name and then make changes rather than start from scratch. Save As leaves
the original package unchanged.
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Intel(R) Platform Enablement Test Suite

Package | View Settings FRun Repot To

Open.. Ctrl+ O
Recent Packages

[ savess.. F12
Save Ctrl+5
Mew Ctrl+M
Edit
Run Multiple

Find Test Case... Ctrl+F
Package Parameters...

Exit

2. Enter the name of the new package in the Name field of the Save As dialog.

3. Specify the desired location and click Save. The new version of the test package is saved in the desired
location.

6.2 Viewing Intel® PETS Automated Power Provider Controls

To view PETS Power Provider controls:

e Choose View > PETS Power Provider Controls.

EJ Intel(R) Platform Enablement Test Suite

Package | View | Settings Run Report Tools
v  Steps Pane

| PETS Power Provider Controls |

Note: Intel® Platform Enablement Test Suit must be connected to the SUT via an Automated Power Provider
Hardware device that is attached to the SUT. The SUT must be defined to be configured with an Intel® PETS
Automated Power Provider (Ex: Intel® APS).

The APS controls are divided into the following two groups: Power Operations and Power Sources:

e Power Operations - Control the power transitions of the SUT:
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(¢]

Power On/Off - Turns the power to the SUT on and off by causing the Power button to be pressed on
the Intel® PETS Automated Power Provider. Power On appears when the SUT is off. Clicking this
button turns the power on. Power Off appears when the SUT is on. Clicking this button turns the
power off.

Reset - Restarts the SUT by causing the Reset button on the Intel® PETS Automated Power Provider
to be pressed.

Clear CMOS - Performs Clear CMOS. A message appears, describing the Clear CMOS operation and
prompting the user for confirmation.

PETS Power Provider

Would you like to perform Clear CMOS?

Clear CMOS sequence will perform the following:

(1) Disconnect all power sources and wait 10000 msec
(2) Shunt Clear CMOS jumper and wait 1000 msec

(3) Re-connect AC only and wait 8000 msec

(4) Disconnect all power sources and wait 10000 msec
(5) Open the Clear CMOS jumper and wait 2000 msec
(6) Re-connect AC only

Unconditional Power Down - Turns off the SUT by causing the Power button on the Intel® APS to be
pressed for 7 seconds.

® Power Sources - Connect or disconnect the SUT from its power source:

@)

(¢]

@)

o

AC - Connects only the AC power supply to the SUT.
ACDC - Connects both the AC and DC power supplies to the SUT.
DC - Connects only the DC power supply to the SUT.

G3 - Disconnects all power sources from the SUT.

When transitioning from AC to ACDC to DC or from DC to ACDC to AC, make sure the SUT remains in ACDC
power state for 7 seconds at least. Otherwise, the SUT may shut down (enters G3 power state).

The DC and ACDC options are not available in Desktop platforms and Workstations.

Intel Confidential



Note:

Note:

®
Running Tests with Intel® Platform Enablement Test Suite l n tel

6.3 Running Tests

To run a test package:
4 Click the Start button or choose Run > Run Package to run the test package's selected test(s) and test
step(s).
Once the Run button is clicked, you will see a progress window showing that the test operator is synchronizing
the time of the SUT clock with that of the MC clock. This is done in order to make sure the test's logs will be
arranged in the correct sequence especially when the test's step event is executed on the SUT.

To manually stop running a test:
d Click the Stop button or choose Run > Stop.

To pause a test while it is being run:
ﬂ] Click the Pause button or choose Run > Pause

To resume running a paused test:
E2 Click the Start button.

If a test step is stopped or paused, Intel® Platform Enablement Test Suite does not stop the test immediately
but allows it to continue until the test step being run has finished. The messages and dialogs that appear as
part of that test step will continue to appear even though the test step has been stopped/paused.

6.3.1 Verify Platform Devices Test Step

Intel® PETS has a new test step named “VerifyPlatformDevices” added at the beginning of each test in most of
the testing packages to verify platform devices in the device manager. In case the device manager shows
unknown devices with a yellow bang, or uninstalled devices, or devices in faulty state, the step will fail and be
marked as a warning. Its logs will display a full description of the errors.

I} Run | Test Step Name Description
1 BringToBaseState Mowe the SUT to a Baselknown State
2 YertifyPlatformDevices Yerify platform devices status from the device manager

The user has the choice to either run this test step or skip it by checking/unchecking the following option in
the Settings menu-bar item. However, it is highly recommended to execute it.

El Intel(R) Platform Enablement Test Suite

Package View | Settings | Run  Report Tools Help-

Systems Under Test...

Current Power Provider...
General Parameters...

3% Package | v  Include FWSTS Data Collection

D Run |1~ Include SysScope Information

1 d < Run Verify Platform DevicesTes@

Collect Test Operator Data on Failure

Enable Audible MNetifications During Testing
Skip Battery Charge Check
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6.3.2 Audible notification during testing
PETS introduces a new feature that provides an alternate method to notify the test operator of the testing
status in two situations:

® When multiple systems are running at the same time (Workshops), or when they're running on long
flows and other tasks could be started (multitasking).

® When testing is complete but the system screen is out of view.

Note: Audible Notifications feature is disabled during testing by default. It can be switched on or off from the Main
menu -> Settings tab -> Enable Audible Notifications During Testing, see the image below.

£ ot Patorm Ensbiement Tezr S A
Package View | Settings | Run Report Tools Help .

Systerns Under Test...

Current Power Provider...

General Parameters...
3 Package Include FWSTS Data Collection

Include SysScope Information

1] Fun | T]
1 q Run Verify Platform Devices Test Step
Collect Test Operator Data on Failure
2 { - perEerE _ _
- v Enable Audible Motifications During Testing
il o |

Audible Notifications during testing feature has three use-cases:
1. When a test step has one of the following results:

o Failed, if the test failure behavior is set to:
i. ‘Manual!, the default registered windows exclamation sound is played upon
displaying the ‘What to do?' dialog box.
ii. ‘Stop’, no audio is played. The audible notifications will be covered during test
finishing flow in Step 2.
iii. Any other failure behavior, the default registered Windows System Notification
sound is played.

o Warning, the default registered Windows Exclamation sound is played. This is for test steps
which may only result in WARNING, and does not abide by the test failure behavior flows
listed above.

o Passed, no audible notification is played as this may cause constant distraction during testing.

2. When atest is finished and the overall test result is:

o Failed, the default registered Windows Critical Stop sound is played.
o  Warning, the default registered Windows Exclamation sound is played.
o Passed, the default registered Windows Asterisk sound is played.

3. When the whole testing process is complete and the message box containing "Test Complete" appears,
PETS plays the default registered Windows NEW Mail Notification.

Customizing the audible tones is available by changing their values from the Windows OS Sound Configuration
dialog. To Open Windows OS Sound Configuration dialog, go to the personalization screen > sounds. The
following dialog appears and new sounds can be mapped to the previous five registered sound names.
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L Sound El

Playback | Recording | Sounds | Communications

A sound theme is a set of sounds applied to events in Windows
and programs. You can select an existing scheme or save one you
have modified.

Sound Scheme:

Mindows Default (modified) | v Save As... Delete

To change sounds, click a program event in the following list and
then select a sound to apply. You can save the changes as a new
sound scheme,

Program Events:

Iﬂwmdows ~
er] Asterisk
1] Calendar Reminder
Close Program
I(] Critical Battery Alarm
] Critical Stop v

DEIayWindows Startup sound

Sounds:

(Mone) P Test Browse...

6.3.3 Skip Battery Charge

“Skip Battery Charge Check” option under the settings tab in the PETS Main menu-bar is used when PETS
couldn't detect the battery due to the following :
1- The OS cannot recognize the DC battery when it is connected directly to the APS.
2- The OS detects multiple batteries including the virtual ones which makes it hard for PETS to verify the
battery status

The “Skip Battery Charge Check” option is unchecked by default, so PETS will run the
“GetBatteryChargeRemaining” Test step as part of its main flow. However, the user can check this option and
accordingly PETS won't run this test step and move to run the next test step.

Intel(R) Platform Enablement Test Suite

Package View | Settings | Fun Report Tools Help
Systerns Under Test...

Current Power Provider...
General Parameters...

v Include FWSTS Data Collection

¥  |nclude SysScope Information

+  Run Verify Platform Devices Test Step
Collect Test Operator Data on Failure
Enable Audible Motifications During Testing

S Skip Battery Charge Check >
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6.3.4 Viewing the Progress of a Test

A summary of the progress of the test currently being run appears in the Steps pane.

To display the Steps pane:

e Choose View > Steps Pane;j the Progress pane appears under the test pane’s title bar.

Detailed information about how a test is progressing can be obtained by clicking on the test to display its
steps in the lower pane. The status of each test step appears in its Status column.

Additionally, the status bar at the bottom of the Intel® PETS main screen displays the following information:
o Network types and IP addresses for the SUT.

o Local agent connection status (connected or disconnected) and the local Agent version installed on
the SUT when the connection is active. This saves the time taken to open the SUT configuration
window to test local agent connectivity.

o System state: SO/S3/54/S5

o ME state: ME on, ME off

o Power source: AC/ACDC/DC/G3

o Time elapsed (the elapsed time for the current step is displayed in the status bar during execution in
the following format: DD HH:MM:SS (DD - Days, HH - Hours, MM - Minutes, SS - Seconds).The progress
timer starts counting from zero for each new test step until it has finished (or timed-out). The timer
freezes if the test is paused, continues when running is resumed, is reset to zero if the step is retried,
and stops if the test is aborted.

. __.___________________________________________________________________________________________________________________|

# "PTT_001" Test, 28 Test Steps
D Run | Test Step Mame Description Params | Failure Behavior | Status
1 BringToBaseState %} Bring the machine to 50 Inherit - MotRunning
2 WriteToMermary Request locality 0 Write 1 to the register TPM_LOC_CTRL_0.Request?| Inherit - MotRurning
3 ReadFromMermary Read the value of the register TPM_LOC_STATE Inherit Ad MNotRunning
4 GetBitField Werify TPM_LOC_STATE_1 locAssigned field is setto 1 Inherit - MNotRunning
5 GetBitField Werify TPM_LOC_STATE_2 activelocality field is setto 0 Inherit A MotRunning
6 GelBitField Werify TPM_LOC_STATE_3 activeLocality field is setto O Inherit - MotRunning
7 GetBitField Wetify TPM_LOC_STATE_4 activeLacality field is setto 0 Inherit Ad MotRunning

Detailed information about all the tests and test steps in the test package, while the package is being run can
be obtained by:

1. Opening the test package’s test results log in the web browser (for information on how to locate the test
results log, see Viewing the results of running a test package.)

2. Clicking the Refresh button in the web browser whenever requiring an update of the information in the
report.

The test’s status (Passed or Failed) appears in its Status column once all the test steps in a test have been
run. If one or more steps end with the status Failed, the status of the test is changed to Failed. A message
pops up when the test package finishes running displaying “tests completed”.
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Intel(R) Platform Enablement Test Suite - a
Package View Settings Run Report Tools Hep Ml Pre-Production SW for testing purposes onl

e eI ©) (intel

X Package "Compliance_Power_G3-5.xmi", 20 tests (ME\SKLWindows\Corporate\All_In_OnelWired_And_Wireless)

D Run | Test Name | Description | Repeat | Failure Behavior | Status. &
10 WE_PH_10 S4-5/CH-O1(@uspend Wellon) 10 SOCHO i mnert | v|  NotRumning

" WE_PH_11 S0CHD o 54-510M3 i net__|v|  NotRumning

B WE_PH_12 S4-610M3 1o S0CMD i net__|v|  NotRumning

13 ME_PM_13 54-5/CM3 to 54-GICM-OFF (without Intel ME Wake) 1 Inherit v|  NotRunning

1 WE_PH_14 S-5I0H3 1o S4-5/CH-O (i ek HE Wake) i net__|v|  NotRumning

0 WE_PH_15 5301 84-510M-Of (8uspend Well O 0 54-510M3 i net__|v|  NotRumning

1 WE_PH_15 SH-5/CH-OI (suspend Well O 10 84-510M3 1 nedt__|v|  NotRumning

17 ME_PH_19 Siraiaht10-55, ME Power Policyis S0-Only S 4 B

1 WE_PH_20 Sralghtto-85, ME Powsr Poly Calls fr 8¢ Operaton i net__|v|  NotRumning

1 WE_PH_23 63 or S4-510M-Owihout Ifel®ME Wake) to 54-510H-Ofwih |[_T nert__|v|  NotRumning

2 WE_PH_25 Warm Reset i nedt | v|  NotRumning

* "ME_PM_19" Tes= 42 Test. Sleﬁ

D Kun | lest step Name | vescription | Params | Failure Behanor | status ~
10 PollngheonByNetvork | Ry Wallunl ME responds o a We-HAN cal- WLAN nert || Notunning
" suspeny % Themachine vansitons to 53 onet || Notunning
B vertesystermstats Verysysten stat afer 08 Sieen @ | et |v| noruming
5 PollngheOrEySignal % nverted- Chck hathere s no ME signal @ | et |v| toruming
1 Powerautancveride PowerButon pressedfor Ssec - ansitons o 80--55 mnert__[v| - NoiRinning
0 vertesystemstats Verty systen ta afer Power Buton overds @ | et |v| noruming
1 Polingheorysianal Inverted - Check hathere i o ME signal @ | et |v| woruming
17 BringToBaseState. 4 ME_PM_19.6 - S4ICM-OF to SSICM-OF - Straightto 65 ME s in PP (PF Inherit v notunning
1 PP_oNins0 w  oeert onet__[v|  Notunning
1 PP_UnkPolyEnabled_in_S05)Rp et Link Polcy3 onert__|v|  Notunning
2 PingHost % Checkinatine Host responds - LA net__[v|  Notunning
21 PingHost % Checkinatine Host responds- WLAN onet__[v|  Notunning
2 PrllingheOnRyNetwnrk G Wait intil MF rmspnns fn 2 WE-MAN call- | AN Inherit v|  NotRunning
3 PollngheonByNetvork | Ry Wallun ME responds o a We-HAN cal- WLAN onet__[v|  Notunning
2 Hinemate % Themachine ransitons to 54 onet__[v|  Notunning
2 veryiesystemstate S veny system state afier U5 Hibemate (7} Inhent v|  NowRunning
2 Polingheomysianal % neried-Checkinathere s o ME signal @ | et |v| nowmuming
z Poverautonoverise PowerButon pressed for Ssec- ansiions o 80--55 onet__[v|  Notunning
» vertesysermstats Verty systen tat afr Power Buton Overds @ | et |v| nowmuming
» Polingheorysianal Inverted- Check hathere is o ME signal @ | et |v| woruming
30 | M | eraroBasestate W ME_P_150- SS/OH-O 10 SSIOM-Of - SUalht o 65 WE s I PPT P onert__[v|  Nowunming
a1 PP_oNins0 w  oeert onet__[v|  Notunning
2 PP_UnkPolyEnabled_in_S05)Rp et Link Polcy3 onet__[v|  Notunning
33 PingHost % Checkinatihe HOStresponos - LAN Innertt v|  NuRwing
34 Pinghost % _Cneckinatine Hostresponds LA onert—|v| _Nowunning o
AN 127.00.1)

Note: The current SUT power status can be seen in the status bar.

6.4 Viewing, Saving, and Sending Test Reports

Once a test package finishes running, the results report of each test and each test step that was run can be
seen. The report can be viewed in the Intel® Platform Enablement Test Suite or in the web browser. The reports
have the same appearance and contain the same information regardless of the viewing location.

6.4.1 Viewing the results of running a test package

The following information describes how a test package’s test results can be viewed:

e The Run Test Results window appears in the Intel® Platform Enablement Test Suite window when
performing one of the following actions:
o Double-clicking a test's Status field

o Clicking on the Test results button in the toolbar (n)
o Choosing View > Report.

e Double-clicking on the appropriate test result log in the web browser. The test results log files are
located in <Intel(R) Platform Enablement Test Suite folder>\Logs. The location of the Intel® Platform
Enablement Test Suite folder is set during the installation process. To make it easy to locate a specific
log file, the format of the name of all test results log files is <package><date><time>. XML
(e.g. Compliance_ME_Power_Gating_2020.01.19_10.42.53.xml)
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6.4.2 Example

Intel® PETS results for running Intel® DAL Compliancy test package on a CFL-S Corporate platform are
updated in the excel sheet below.

A 3 c ) s « L M
Project: CFLS MELZ W - GNP based pltfom Corporate SKU |
Phase: Alpha | WLAN & LAN Package.
Notes: N/A | [[rotal Jpercentage
[P compiee Rate
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0.0% [Block Rate
1 989% [To0o

‘Network Factor

Integrated Clock Control ICC) Compliancy
CC boot profie selection from ICC configuration o7

PETS Both Tobo

240]1cc_TST_02 Tor Standard confguraton o PETS Boh Tobo
241[1ccTsT_03 for o PETS Boh Tobo
242[1cC_TST 06 [ 9 Extended configuraton oT PETS Boh Tobo

2 Dispiy Chipse hitialzaton header dota o7 FETS Som Tono
Media Playbac
‘245 ed_001 Vit defout coniguraton sefings for Protected Aucio Video P or anual ToDo
246 led_002 [Verfy LSPCON Port configurston  Frvare rsge Tool [P (ol for GFL) or Tanual Tobo
247l _003 [Verfy pieral Por confuration n Frmware age Toa 1 or Tanual Tobo
Very PAV Ensbied n BOS Tanuat
2ag e 004 Gry 1 e S 505 e Gy A i) or To0o

Intel DAL applicaiions cleanup
ication instalation and load

il DAL test
1101 DAL communicaton channeloxeross

et Plaom Tust Technolog el® PTT)Compiancy
s oo cxs bers r oo

sl oz it T indows* 10 Base Funcionaiy s ? o

s o Tt cles and hysce resence s ? o

o am Wingous 10 8o niegat E )

s one Windous: 05 todker 7 pecton RSl | 6o o

sl e Windous: 10 sivse e ? o

s o7 i cosoc Windows™ Gk T st Tl o

SeiFrr e et T Enabe/isabe om 8108 Tl o

SelFrr o oue:Tamsion Testng uth el P Ensbies e B [T

SelFore s Ao Lot Al o Baten emors oM o [ 0

2o

b e Sucessil Vi oot o indons? lnia! 0

st ooz Urscaresostto 05 et o0

Setre o8 Faled M oot ol o bk et o0

Sssore oe sV oot o indons* o

Selarc o o bl Seine i : -

O I oot oncamer R i M2 consumer | ISR | S MEi2 AW Consumer|_crLs Corporate || CFL-U ME12 AW Consumer || CNL-U ME12 FW Consumer |

® i (>

6.4.3 Report Viewer

The Report Viewer allows easy navigation between reports by clicking on them in the left hand pane. It is
possible to export PETS logs, import previously exported logs, and delete test result log files. Also, viewing,
navigating, and selecting several older/newer logs is possible in the list prior to saving or copying them into
other folders. Additionally, simultaneous export/import actions for multiple PETS logs is possible as well.

[ Feport Viewer - O =

| Eoot sciecies Logs [l inpotlogs I sicis Seiocted Locs ]

PTG ] LRSI IS I 1 Sa0 AUILVe

ck

[ Comglance_DAL_202 |

[] Compancs_ICC_LP_3000.04 14_2
[[] Comphance_SpiRashCorfiguration_
] Comgliance_PTT_202004.14_23.3
|| ME_Compliance_FM_2020.04.14_:
7] Comphance_PTT_2020.04,14_143
[] SetupEnvimnment Test_2020 0414
) SetupEnvianment Test_2020 0414
[] SelupEnvimnment Test_2020.04.14
[ SetupEnvionment Test_2020 04. 14
[ Complance_PTT_202004.14_13C
1 Comphanca_PTT_2020.04.14_13.0
] SetupEnvimnment Test_2020 04,14
L] Complance_PTT_2020.04.14_06.2
] Setup Envianment Test_202004 14
[] ME_Compliance_FM_2020.04.14_1
[ Comphance_MECommanSenvces_:

Run Dabe- 41152020 1:08:30 AM Consobe Wersion: 10.1830.0.0 Agent Versson: 10.1820.0.0

Systemn Under Test Result Statistics

SUT Overview
Hame
Descrigtion
Platform Version
Platform SKU
Platform Type
Manageability Intertace
Operating System

EHL Passed
ELKHARTLAKE
Cansumer
Mabile
WIRED_OMLY
Windows

Failed

Conditien
SkKip

] ME_Compliance_RST_202004.14,
[ Complance_PTT_2020.04.13_14.0

] SetupEnvimnment Test_2020.04.1
[ SetupEnvirnment Test_2020,04.1

] Complance_PTT_202004.13_01.2
] Compliance_PTT_2020.04.13_00.3
1 Comphanca_PTT_2020.04.12_23.4
] Complance_PTT_2020.04,12_234
[ 1 Complanca_PTT_2020.04.12_232 %
€ 3

General Host Settings
User Name
LAN IPwd Address
LAN MAC Address
[Port Number

Power Settings
Low Power Enabled
Loww Powier Policy
Low Power Source
Policy
Deep Sx Enablad

Intel® APS Settings
Power Provider
PETS power provider

ace

admin

10.12.227.35
O0-E0-4C-00-08-98
12000

DeepSx
Dizabled

De

False

InteliR) 4PS 3

True

Location: C:\Progeam Files (xB8]\lntel\intel(R) Platform Ensblement Test Suite\Loge\Log_XMLs\
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The Viewer includes the following information:
e Statistics on the tests run.

e Tests skipped (deselected ones).
e Steps not run because they were deselected, or earlier failure/abortion of a step failed (clicking the stop
button).
Note: Aborted tests may also include some failed tests. It is therefore recommended to view the PETS logs to check
if any aborted tests actually failed before being aborted.

e Information about the SUT on which the tests were run, including:
o ME Platform: BIOS Version, Intel” MEBx Version, LMS Version, MEI Driver version, Graphics Driver
version, LAN Driver version, WLAN Driver version, OS Details [Edition, Version ,Build Number, Build
Type, OS Architecture, OS Physical Memory Size, OS Virtual Memory Size] and System Directory
o TXE Platform: Host Information, Firmware Information, and Graphics Driver.

¢ Information is collected using the FWSTS Data Collection and SysScope Information tools.

El Intel(R) Platform Enablement Test Suite

Package View | Settings | Run Report  Tools Help
Systems Under Test...

Current Power Provider...
General Parameters...

® Package | +Cnclude FWSTS Data Collection_>

I} Rurn T*" Include SysScope Information

; . ¥ Run Verify Platform Devices Test Step
Collect Test Operator Data on Failure

: PR R A '

Enable Audible Motifications During Testing

Skip Battery Charge Check

Test Operator Additional Feedback upon Test Failure.
‘Collect test operator data on failure’ feature is disabled by default. It is enabled it by checking “Collect Test
Operator Data on Failure” checkbox under Settings in the Main Menu
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Intel(R) Platform Enablement Test Suite

Package View | Settings | Run Report Tools Help
Systerns Under Test...

Current Power Provider..,
General Parameters...
¥ Include FW5TS Data Collection
D l e l 7 ¥ Include SysScope Information
. +  Run Verify Platform Devices Test Step
@Ilect Test Operator Data on F@
Enable Audible Motifications During Testing
Skip Battery Charge Check

K &

When enabled, regardless of the failure mode (except for Manual), a message box with a single input window
appears allowing the test operator to add additional data about the failure at that point.

Test Hama | Dmmcripisan thul.- F ashyrn Betarmo Sxabun

BP0 Do ripoor Mode est 1 mhert ¥ i (1)

M:ll'l b

LA -&-\t..i'!'&'-fj

Fen | Tl Step Hams | D riptain | Patavmin | Fadhars Bobawor | Sl

For all Question/Answer test steps, the window above will not appear. Instead, a single input window will be
added within the same message box that allows collecting of additional information at the time the test
operator selects Yes/No, at all times.

For all Manual failure behavior tests, a single input window is added to the bottom of the “What to do” window
allowing the test operator to provide additional data/information/observations about the failure at that point.
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@ Test Case [SPL_D01] Falled on the following step fn Fled. please choose what fo do next

1 |BringToBase Bring the maching to S0 In Progress

? | TEReacRegl PCIERASE HofRunning

D Step Mame Deseription Status

lrinard

In all cases above, the window will allow up to 1024 input characters.‘The test operator’s additional input will
be copied into (appended to) the Intel® PETS log once the dialog box/message box hosting the input window
is closed/cleared.

=] %P&wer BringToBaseState
[ ¥ 18nng he madhine io &

Finiphed SO0 103607 S04 A, Searted OTANI0NE 60T 500 A |
Action

6.4.3.1 Importing Logs

To import log files:
1. Open the Report Viewer.
2. Click Import Logs.

S

SetupEnvironment Test_2015.12.27 14.39.28
SetupEnvironment Test_2015.12.27_14.11 59
SetupEnvironment Test_2015.12.27_14.08.35
SetupEnvironment Test_2015.11.26_16.45 55

led_Packa )_2015.11.26_12.00.08

Platform Enablement Test Suite

151125 09.28 06
3. The "Browse For Folder" window opens. Navigate to the log folder.
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Browse For Folder “

& (Ml This PC -
Il Libraries
[ 7' MNetwork
4 @ Control Panel

5 Recycle Bin
bl AMT_115
I Compliance_,AMT_2015.12.27_14.18.45
I Ju Docs

L\ Do i

Note: An error will be received when trying to import PETS testing results from an empty directory or a directory
that does not contain valid log files.
Failure

Importing PETS Testing Results
It seems you are trying to import a directory that is empty or does not include valid log files.

Note: When importing a log from a directory that already exists, a message appears informing the user that the "Log
directory <dir name>" already exists. Do you want to overwrite it? This message only appears when the content
in the directory conflicts with an existing one.

Question

"Compliance_SpiFashCorfiguration_2015.11.12_08.35.07" already exists, Do you wart to
ovenwrite it 7

6.4.3.2 Exporting Logs

To export log files:
1. Open Report Viewer.
2. Browse the report/s and select the log file/s you want to export from the list.

3. Click Export Selected Logs.
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. .
T Soum EmvroenToa 201212 27 140 55 Platform Enablement Test Suite

[v] SetupEnvironment Test_2015.11.26_16.45.55

D Untitled_Package_{not_saved)_2015.11.26_12.00.08

[+/] SetupEnvironment Test_2015.11.25_09.28.06

4. The Export Report Settings dialog opens. Set the desired export format from the following report
formats: Standard PETS log (XML), HTML (Portable), or Excel Spreadsheet.

= Export Report Settings Bl

Report Format:
() Standard PETS log fanl)

(®) HTML {Portable)

() SpreadSheet {Excel)

Destination Directory:
CAUsers‘\ntuser\Desktop

5. Click Browse to set the Destination Directory. A dialog opens prompting you to select the target directory
in which the logs are saved. Clicking Browse again sets the previously selected target directory to be the
new default directory.

6. Click OK. Intel® PETS saves the logs in the requested format in the target directory.
Note: Intel® PETS remembers the last destination a report export was saved to.

Note: Intel® PETS generates the HTML output and Spreadsheet only when choosing to export logs. They are not
available by default in the “Logs\Log_XMLs" folder.

When exporting an HTML report, the file can be shared with other people without consuming any extra
resources and can view it using any Internet browser. This report captures all the test steps for each test.

The HTML Report Type includes the following:
e Information about the SUT on which the tests were run.
e System Scope information.
e  Statistics on the tests run.
e Status for each test/s and steps.

Note: Users can filter the test results on either the "test level" or "step level” in the same manner for both cases

according to their ending results whether they are passed or failed. A tooltip will appear guiding the user to
filter the test results accordingly.
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Result Statistics

«ID «—» Cradbion Sy 4 S TP —
Compliance_PTT Tests Details: Passing only | Failure anly

Mot Running | All

Teest Name [eeraticn Murmsber

Status

Besult Statistics
m il 1 m Condition Skip- 8 Passed  Failed Condition Siop Not-Running

Nee-Running: 7

0 0
Compliance_PTT Tests Details: Passing caly | Fallure only | Abaried ondy | Skipped ondy | Not Running | Al 1.0 2 5% 0 8
Click to view Failed tasts
i) Test Name Iterabon Mumber Status

Note: Another tooltip will appear when pointing the mouse at the Passed ,and Failed ,Aborted and Not
Running results labels, prompting the user to click in order to filter the test results accordingly. For example,

Clicking on “Passed" label as shown below, filters the test results to show only passed ones. The same
applies for “Failed” test results label as well.

Resulr Seanistacs

I aGCGo» a2 CXD

Passed Failad Condilion Skig Nt Runnihg
SetupEnvironmentTest Tests Details: Passing only | Fallure only b ppad ol A ]
I Test Hame Beratson Numbser Sistun

Intel® PETS also allows users to export and view the Test Results Report in Excel spreadsheet format. You will see tabs
for multiple sheets.

Pre-Work format sheet - Displays the test results in the pre-work format (only test case and sub tests are
included).

Verbose format sheet - Holds a verbose version of the log (all test steps are included).

- SUT Info sheet — Displays the System under Test information

- MC Info sheet - Displays the Management Console information

- Parameters sheet — Displays General and Package information
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mE % ¢ Cmerpliarecs_ bl 7104 12 L2 F1A Plpematobarnt oty - Lol rm -0 x
HOME BGDET  PAGHLAYDNT PORAMAAL DALE  BDODA  WDA  FostBesie PDF  TLAM A Sbesd -'I'

Al . .ﬂ ipdl] Halforms [rabierment Tonl durdle w

intel B] Platicerm [nablemant Test Sulte

Pohigr  Comphos el omd  [MUETE || Srdtaaion o g stbbentfe sl ndg)
P Darw  RITEIE 1T 30080 PR

o

PraWadk  werbode | WiTWe | MOWe _ (&

By default, Export Selected Logs and Delete Selected Logs are disabled until the user selects a log.

When exporting a log/s from a directory that already exists, a message appears informing you that the "Log
file <log file name>" already exists. Do you want to overwrite it? If “Yes” is clicked, the change will be applied
to the current file only.

On the other hand, clicking on “No” will skip the current file and “Cancel” will terminate the whole copy
process. This message only appears when the content in the directory conflicts with an existing one.

The File " ) S Flash el slion_2015. 12031447 14 Base Lo wwl =
alrmachy exists, Do you wand Io ovorerilo £7

6.4.3.3 Deleting Logs

To delete log files:

1. Open Report Viewer.

2. Browse the report/s and select the log file/s that you want to delete from the list.
3. Click Delete Selected Logs.

T,
E
5 Emn Test_2015.12.27_14.39.28 P
S::E::En::::gT:::mw5.12.2?:14.11 59 ‘ -
[V] SetupEnvronment Test_21151227_14.08.35 Platform Enablement Test Suite

2015.11.26_16.45

SetupEnwron P .11.25_09.28.06
4. When prompted for confirmation, click Yes.
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Question

& Are you sure you want to delete the selected log directories?

) G
6.4.4 Test Results Report SUT Information

To display information about the SUT in the Test Results report:
e Click the Show button at the top of the report.

To hide information about the SUT in the Test Results report:
e Click the Hide button at the top of the report.

6.4.5 Test Results Report Test Information

The Test Results Report provides a high level summary for each test. You can also view detailed
information—as explained below.

% You can filter the test results according to one the following criteria:

- Failure Only: PETS only displays failed and aborted tests.

Platform Enablement Test Suite

="

Spscerm Undee Fase Resun Stavstics

,, i

1 niy)

Platform Enablement Test Suite

B 12770412 3081370 Comso Verion 5141, g arsion: 5182
Systom Under Test
Teata For: Gompisnce_ME_Power_ Gating xmi (WEVSKL Windows Corporate Wisle Wieiess_Ony)

Tests details:

@ MEPM 44

tests).

Systean Under Test Result Statistics

ool

T deaie: Faius oy | Passng o) 1@

- ot Run. Failon previous lestste
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« To view more information on a specific test, click on it to see the following:
A detailed secondary window appears that allows you to open the details of each step in the test,
expand all, collapse all, or see all failures of that test.

||

Test Case: ME_PM_1

 Power_ G2 ¥ 1oty

Steps details: Failure only/All  Expand |=

4 Power BringToBaseState
(1) ME_PH_1.1- SOMO to SYM-Of (PP1, DC, Host goes o §3)- Bring ine machine fo S0

8 &% Power. PP_ONinS0
(2)setppt

Action
PowerPackage Parameter value
Result
FP1

4% General PingHost
(4)Checkthatthe Host responds - LAN

[ Report name: Complianoe_Power G355 20120415_162520 B

K2

% You can also click the Compliancy Guide tab on this window to open this test in the Compliancy
Guide.

:
E]Test(‘asiwer-M[ij . = B3| 8
g
(URSRSHORERN | Complianey Guide

|Test 1D: |ME_PM_1.1

|Test case Title: |so/mo e s3m-oF

|Mandatory/0ptional |mandatory

[Form Factar [Mebile

Original Power State: S0/M0;Target power state - 53/M-Off; LAN Power Palicy - Power Policy

Description: ;
i =1, WLAN Link Policy - '#2: Enabled in S0, Sx/AC’; power source - DC; Trigger: Host go 53

|objective: This test chacks for the system power flow S0/MO to S3/M-OF

Configure BIOS to keep the system in S5 after exiting G3
Set the Original Power Policy to 21: ON in SO

Set Wireless Link Policy "#3: Enabled in 50, Sx/AC". Note: This is required only
when wireless is used

Set the power source to DC

Boot the system to SO/MO i.e. make sure OS is up

\erify that Intel ME is on (Intsl ® AMT answers ping vis LAN/WLAN interface)
Put host into standby

[Verify test pass/fail criteria

|Test P_ass/Fail that zhould be assarted, indicating ME is in Moff. If APS iz not svailable, thiz can be dene by
a

Host goes to 53 state, Intel ME becomes Moff. This can be done by checking SLP_A= signal,

pinging Intel AMT IP address with both wired and WLAN intarface to make no ping responses are
received

‘Cn’l‘eﬂ

|Test ID: |ME_PM_1.2
[Test case Title: [s0/m0 e s3/M-0F

\Mandatory/Optional |Mandstory

|[Form Factor o, ME. we-Server

1]

Report name: Compliance_Power G3-55_20120415_152820 o
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6.5 Results Worksheet Generation

The Results Worksheet is a new addition to Intel® Platform Enablement Test Suite that enables Intel®
PETS users to update an excel sheet with the latest results of a set of tests performed on a defined SUT.
This excel sheet provides statistics on the percentage of tests not performed, passing, failing, and
blocked per SUT. Example and usage instructions are given below.

6.5.1 Important notes
The excel sheet template is not embedded into Intel® PETS. To get the template for Intel® CSME 12.0

based platforms, contact your CE representative. Excel templates for other Intel® ME/ TXE projects will be
available in the future.

Please note that the results worksheet will be updated and saved in an excel file regardless if the console

has Microsoft Excel or not. To be able to view the worksheet with all results statistics for your SUT, please
make sure your console has Microsoft Excel.

6.5.2 Usage

Once Intel® PETS logs are ready, follow the steps below:

1. Select “Generate Results Worksheet” option from the “Report” menu-bar item as seen below.

@ Intel(R) Platform Enablement Test Suite - ] ®

Package View Settings Run Tools Help
View Reports

Open Report Folder
Generate Results Worksheet

2. Choose the desired SUT then import an excel template, where:

a) SUT Name: The drop down menu shows information about user-defined SUTs currently
available in in Intel® PETS. The selected option should belong to the desired SUT to generate the
results sheet for.

b) Excel Template: Click “Browse” to import the Microsoft Excel template file containing the set of
tests and results to be updated.

B Generate Results Workshest - x

Choose SUT and Excel File

SUT Name EHL - ELKHARTLAKE, Consumer, Mobile, WIRED_ONLY

Excel Template |
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3. After importing is complete, the “Generate Results Worksheet” dialog will be updated with additional
requested input for mapping with excel, where:

a) Worksheet to Fill: The drop down menu shows options of all sheets in the imported excel
template file.

b) Test Name Column: Refers to the column name containing the list of tests.

c) Result Column: Refers to the column name containing the test results to be updated

B8 Generate Results Worksheet = b
Choose SUT and Excel File

SUT Name EHL - ELKHARTLAKE, Consumer, Mobile, WIRED_ONLY W

Excel Template | Desktop\Desktop\EHL -ELKHARTLAKE - PETS Compliance Test Results xisr|

Mapping with excel
Worksheetto Fill EHL Consumer

TestName Column
Results Column

Note: Click the Reset button to clear all input values.
Note: The input for mapping with excel will be updated automatically by Intel® PETS according to the imported

excel file. The user might have to update these fiels manually if Intel® PETS cannot locate the “Test Name” or
“Result” columns (i.e. value will be N/A).
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Choose SUT and Excel Rle

SUT Name |EHL - ELKHARTLAKE, Consumer. Mobile, WIRED_ONLY s

Excel Template [ Desktop\Deskiop\EHL -ELKHARTLAKE - PETS Comphance Test Resutsxism| ( Bowse )

Mapping with excel
Worksheet to Fill EHL (:‘,qnsumar

TestName Column |
Results Column |:|

4. After successfully setting all input values, click the OK button to save the updated excel file in a user
defined location.

6.6 Using the Compliancy Guide

Intel® Platform Enablement Test Suite allows you to display any test in the Compliancy Guide.

Note: This feature is supported in Internet Explorer 7 or above, and in Firefox 3 or above.

To display the test in the Compliancy Guide:

1. Right-click on any test in the PETS test pane.

The right-click menu opens.

i unselect Test
Select All Tests
Unselect All Tests

i Show Test In Compliancy Guide

| Report...

2. Select “Show Test In Compliancy Guide”.

The relevant test opens in the Compliancy Guide in a separate pop-up window.
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7 Changing Package Parameters

You can use the Package Parameters dialog to modify the time-out times, LPT Port, WLAN IP, WLAN and LAN
Mac Addresses, and other parameters of a test package, to reflect the settings required for the specific
system being tested.

If you change a package parameter and then save the test package, the new settings will be used when you
next open the package.

To revert to the original default settings, navigate to the <PETS Installation Folder>\Packages\<Package

Name>.xml.global file and delete it. When you subsequently open the package, it will use the original
settings.

Package Parameters are specific to each test package. Any changes in the Package Parameters do not affect
the Package Parameters for any other package, even if they have the same name and meaning. Different

packages have different lists of Package Parameters.

7.1 Changing Parameter Values

To open the Package Parameters dialog in Intel® Platform Enablement Test Suite:

1. Open a test package.
2. Choose Package > Package Parameters.
B Package Parometers o o

parameter search TSR

Parameter Value Descnption
SOTOSSOELAY 300

Mapcrmm aliowed tema for 50 o 55 transton in seconds
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To search for a package parameter:

Go to the search box next to the “Search Parameter” label and type in the package parameter name that
you're looking for. The parameters will be filtered where the package parameters specification table will only
show and highlight the parameters that have the user searched text in their name.

' T Package Paramaters o x i

Type a parameter name you want to look for in the
search box

Parameter Search QIR =gy cee

To change parameter values:

Note: The values of Package Parameters that are time-related are represented in seconds.
1. Double-click the value of the parameter you want to change; the value is selected.
Type in a new value for the parameter.

2
3. Repeat steps 1-2 for all the parameters you want to change.
4

Click OK.
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The following table describes the package parameters of test packages.

Parameter Description

APSDELAY

SOToS5Delay

SO0ToS4Delay
S4ToS0Delay
S5ToS0Delay

SO0ToS3Delay
S3ToS0Delay
ResetS0-S5-S0Delay
IdleTimeExpireDelay
MEWakeUpPing
PingTimeout

STABLEDELAY

CheckMETimeout

AfterPingDelay
G3Exit
ACReconnect
COMPLIANCYPATH
WirelessDelay
Timeout
AfterRcpOpDelay

RestartDelay

AMT_TC002_AsfTablesGe
neration_TmsFolderPath

Remotelnterface

AfterPopDelay

Intel Confidential

Many of the Intel® Platform Enablement Test Suite tests include a step called Bring To Base State. This
operation includes sending the machine a G3 command (disconnecting all power sources) followed by
an ACDC command (connecting the AC and the DC power supplies), followed by a power-up
command.

The APSDELAY parameter allows you to adjust the delays between these three operations. For the
power packages, the default delay is 5 seconds.

Example of use: Some platforms require more than 5 seconds to complete a G3 operation, so you
should lengthen this parameter when running tests on these boards.

Maximum allowed delay time for transition from SO (platform is on) to S5 (power cable is connected
but platform is off)

Maximum allowed time for transition from SO (platform is on) to S4 (hibernate)
Maximum allowed time for transition from S4 (hibernate) to SO (platform is on)

Maximum allowed time for transition from S5 (power cable is connected but platform is off) to SO
(platform is on)

Maximum allowed time for transition from SO (platform is on) to S3 (standby)
Maximum allowed time for transition from S3 (standby) to SO (platform is on)
Maximum allowed time for SO to S5 to SO transition

Maximum allowed time before ME goes to Moff in Power Policy 2 (M3->Moff)
Time to send pings when waking ME from M-Off

Time to wait when verifying system is not responding to pings

Wait after 'sensitive' steps to ensure system is ready for next step. ‘Sensitive' steps are those that
involve changing the SUT power state, for example, moving to ACDC or G3. Such operations leave the
SUT unstable for several seconds, and PETS needs to wait for the system to become stable before
continuing to the next step. This value (in seconds) tells PETS how long to wait.

Time to wait when verifying ME is off or on. Check that ME is on for 20 seconds. This is only for a
negative test when ME is off.

Delay after doing ping till ME goes to M3 state

Maximum allowed time for exiting G3 (all power sources disconnected)
Maximum allowed time for reconnecting AC power source

Path to the Compliancy Guide help for each test

Delay before wireless link preference could be set again

Time to wait in ‘Delay’ steps and many other cases

Time to wait after a Remote Control operation

Maximum allowed time for restart

Path to place the tables file in test AMT_TCO002

Remote interface to use for AMT and KVM operations, can either be LAN or WLAN

Delay after displaying a pop up window
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Parameter Description

KVMOptinFWTimeout Timeout for Intel’ KVM technology Opt-in message to close

CD_IMAGE_PATH Path of CD image used in IDER Boot

Floppy_IMAGE_PATH Path of floppy image used in IDER Boot

1MinuteldleTimeExpireDe Idle time of ME to go from M3 to M-Off when Idle time is set to 1 minute. The actual time the system
lay takes to go to M-Off is typically at least 70-100 seconds. Units are seconds.

PreSOTransitionDelay Wait when in Sx state before performing a transition to SO. Some platforms cannot perform the

transition without waiting some time in Sx. Units are seconds.

SOinitializationDelay Wait in SO before transitioning to Sx state. Units are seconds.
RCOPowerCycleDelay Maximum allowed time for RCO Power Cycle operation to complete. Units are seconds.
Note: Please be aware that not all package parameters will be the same for all packages.

To load package parameter default values:

e C(Click "Load Defaults" and then "OK".

Note: By clicking Load Defaults, PETS resets the package parameter values to their original values (the initial
values when PETS ran for the first time). Each package has its own parameters.
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7.2 Test Step Parameters

[ VerifyMeSystemState O ¥

Parameter Search

Parameter | Deseription
SOTOSIDELAY Masimem alowad time fior 51 to 53 transtion in seconds

To load test step parameter default values:
¢ C(Click Load Defaults and then OK.

Note: By clicking Load Defaults, PETS resets the test step parameter values to their original values (the initial
values when PETS ran for the first time). If a parameter is shared between the test step and the package, the
changes are reflected on both sides.

To view step parameters:

e Click the help icon beside in the Params column for steps that accept parameters.

| Description Params | Failur

l
5 BringToBaseState i ME_PM_1.1-S0/M0 to S3/IM-Off (PP1, DC, Host goes to 53) - Bring thei (7]
2 PP_ONinS0 (%  SetPP1 | o |
3 DG i% Setthe machine to DC only | I
4 PingHost Check that the Host responds - LAN | I

A window opens displaying the parameters related to the selected step (similar to that shown in Changing
Parameter Values). You can view and change the parameter values as required.
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7.3 Power Transition Timeouts

The power management packages contain a definition of the power transition time-out. When the Intel®
Platform Enablement Test Suite sends a command to perform a power transition, it polls the Intel’ PETS
Automated Power Provider for the power state to verify that the power transition took place. When the time
specified by the time-out has passed, the test is considered to have failed.

The following table lists the time-out for each power transition.

Power Transition Macro Name Time-out (sec)
Unknown State to SO UnkToSODelay 5
SO0 To S3 SOToS3Delay 5
S3To SO S3ToS0Delay 5
SO0 To S4 SOToS4Delay 5
S4 to SO S4ToS0Delay 5
SO to S5 SOToS5Delay 5
S5 to SO S5ToS0Delay 5
Note: These values are valid for an Intel® CRB and you may need to change them for other systems. To change the

delay times for your specific platform, you must modify the settings in the Intel® Platform Enablement Test
Suite's Package Parameter's dialog.
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8 Changing General Parameters

The General Parameter dialog can be accessed through Settings > General Parameters menu item.

General parameters are the parameters that are shared among all the packages in PETS. General Parameters
are used to resolve the differences between different platforms supported by PETS. Modifications to one of
the parameters will be affect all the steps that utilize it.

You can use the General Parameters dialog to modify the general parameters listed in it. Currently, PETS
defines some general parameters for the commonly used "BringToBase" step as shown in the image below:

Section Parameter  Description
Bring ToBaseState CwverAll TimeOut Max. allowed time for Bring Te Baze in sec.
_Pj]gi.ng'l"lmeOut Ma. time for getting a respond to ping from SUT in sec.
MeOnByMNetwork Time... Max. time for Polling Me On By Network in sec.
VerifyMeSystem State | PolingDelay Delay before checking the expected states for (FF)in sec.
Consistencylnterval Time to check that signal stays consistent in sec.

Load Defaults

8.1 Changing General Parameter Values

To modify the General Parameters:

1. Double-click the value of the parameter you want to change; the value is selected.
2. Typein anew value for the parameter.

3. Repeat steps 1-2 for all the parameters you want to change.

4. Click OK.

To load general parameter default values:
¢ Click Load Defaults and then OK.

By clicking Load Defaults, PETS resets the general parameter values to their original values (the initial values
when PETS ran for the first time). If a parameter is shared between the test step and the general parameters,
the changes are reflected on both sides.
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9 Running PETS in Package Design Mode

Package Design Mode provides additional capabilities such as creating packages and tests from scratch,
modifying existing tests, or adding extra tests and steps.

Test steps are the building blocks for PETS test packages as they determine the specific functionality for
each package. For example, you might need to ping the SUT as part of your test; a test step named “Ping”
provides this functionality. If you need to add a delay after changing the SUT power state, you can use the
“Delay” step to provide a delay with a configurable duration.

PETS provides a large selection of out-of-the-box steps which are grouped into “Test Sets” depending on the
functionality they provide. For example, the power steps can be found under the Power plug-in.

Each step has a name, description, input parameters and output parameters. Sometimes, you might need to
add a more specific description for the step depending on the functionality the step provides for your test.
For example, the CMD step is a very general step used to run a command. After adding it as part of your test,
you might wish to call it “Running the <Name of tool> tool” or “changing a setting” this will make your test
easier to understand.

You can filter the steps to get a specific plug-in step or use the free text search option to search for the step
in all plug-ins and various tests or search for one in the Search Step bar.

9.1 Creating a Blank Test Package

You can create new packages and tests, add steps, and run the test. This enables you to run tests during
package building and verify the results are as expected, and modify the test package as needed.

To create a new test package:
1. Choose Package > New. The Package Design Mode panel appears on the left side of the PETS interface.
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[ Intel(R) Platform Enablement Test Suite
View  Seftings Run Report Tools Help

(LAN: 192.168.1.47, WLAN: 192.168.1.21)  Elapsed Test Step Time: 00 00:00:00

2. Add tests to your package, as described in the next section.

Intel Confidential

Open.. Ctrle0
Recent Packages
Save As.. Fi2
Description Repeat| Failure Behavior | Status
o Boot Guard Boot Status Check Inherit ~|  NotRunning
Run Multiple
St Error Status Cote chetk Inherit ~|  NotRunning
Package Parameters...
Exit
Run | Test Step Name Description Params | Failure Behavior | Status
BringToBaseState % Bringthe machine to S0 Inherit ||  NatRunning
B | verifyPlatombDevices % verify platform devices status from the device manager Inherit  |v|  NatRunning
M | TEReadRegisterf romPeics FWSTSE inherit  |v|  NotRunning
M | TecHpitFia FWETSE FACE (7] inherit  |v|  NotRunning
M | TeGe@itFiel FWSTS bis [6:9] (7] mherit  |v|  NotRunning
M | TeGetsitFiel FWSTS hits [31] innerit ||  NotRunning
M | TBReadResisterF romhemary Bootstatus Inherit ||  NotRunning
B | comvertGetBitField Convertinteger it value to string Inherit  |v|  NotRunning
B | UpdateGlobalParameter Update global parameter (7] Inherit ||  NotRunning
M | convencetsitFiel Convertinteger bit value to string nherit  |v|  NotRunning
M | UptateGlobalParameter Updlate global parameter inherit  |v|  NotRunning
M | convenetBitField Convert integer bit value to string mherit  |v|  NotRunning
M | UndateGinbalParameter Update giobal parameter mherit  |v|  NotRunning
M | TeGetgitField M Boatstatus Inherit || NotRunning
M | TeGetsitField M Boatstatus Inherit  |v|  NotRunning

te
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9.2 Adding Tests to a New Package

1. Click Steps Kit > New Test.

® Test Set:

Search Step:

Mame:

2. Right-click the test pane and select New.

® Intel(R) Platform Enablement Test Suite - oEE
Pacge Vew Satogs_fun_Reson_Took Pre-Production SW for testing purposes onl
‘esing
eps o | L 8
Gt @iz 0, [Run | TestName [ Dscrption Regest| Faiurs Beior | Saus

Seach e

(WAR:127.001

The Test Properties window appears.

Name: [NFC_o01

Description: |‘u’eﬁﬁ' Intel ME FW and module connectivity

3. Enter a unique Name for your new test, add a Description, and click OK.
4. The new test is loaded and displayed in the test pane. Add test steps, as described in the next section.

5. Repeat this procedure whenever you wish to add a new test.
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9.3 Adding Steps to the New Test

e Select Search Step under the Steps Kit tab.

. |
Steps Kit |“
[\&NEW Package l,l l& New Test J
() Test Set:
. Search
Search Step ==®) Search Step: Delay
Radio Button Step Bar
Various
Steps
Description:
Preform a delay for a given number of miliseconds.

9.3.1 Configuring Step Properties

You can edit the following step properties in the Properties tab of the Package Design Mode panel:
e Step Description.

¢ Failure Behavior - Enables you to instruct PETS how to proceed after a test step has failed. Possible
values: {Inherit, Next Step, Next Sub Test, Next Iteration, Next Test, Stop, Manual}.

e Use Local Agent - Indicates whether the step should be executed on the local agent (SUT). Possible
values: {True, False}.

e Sub Test Name - Indicates whether the selected step is the beginning of a sub test. (Sub test is another
level of hierarchy and will result in GUI and reports). You only need to set this value for the first step in
the sub test - do not configure this parameter for the other steps in the sub test.

e Setting Step Parameters — Each step has its own set of parameters depending on the functionality it
provides. For example, the Ping step has the IP to ping and the Delay step has the total delay in seconds.
For more information, refer Configuring Parameters.
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il ———
w Properties |

BringToBaseStaie
Description: | |
Failure Behavior: Inherit b4
Usze Local Agent: Falze w

Sub Test Name: | |

Required Features: || | | ;;F"|

Parameter Value
true

SkiplLocal AgentC..
SkipPingHostOs
DelayAfter33
SetMeldleTimeOu. ..
Bring ToBaseFailure
UseWirelessAddr...
Timeout

Bring ToBaseFing...
PollingMeByMetw ...

Required Features let you Add Required Features to the selected test step in two
ways:

1. Either by writing the Required Features in the text box

2. Or by clicking the Configure Feature(s) selection button wich will
open the below window that enables you to choose Prerequisites from
the list to be added to the selected test step.
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Required Feature(s) Selection

Features:

[] Power_WaoWLAN

To add a step to a test:

Select the step to be added and drag it from the Package Design Mode panel to the Test Steps Data Grid

view, as shown in the following figure.

in Fun_| Tast Nama Descrgion
1 | & |swosme

CFUGR lackinguniocking - Mansfacuring Wade

Repaat| Faihars Betareo
1 Inhert ¥

@@

Staben

HetRznning

10| Run | Tast Step Mams | Descrgtion
1 (i} Toileiniiae R Bring the masune ts 00
N: | = e
& ™ b, =
¢ b (LR
+
Ea

Description,
Prekars & daley hr o grven susber of rellscored

Tt 11 ARS 103 18R LT

Inbare
Inhare
e
innart
e

The step is added, the step IDs are rearranged, and the Steps Grid Header is updated.
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9.4 Configuring Parameters

9.4.1 Configuring Package Parameters

When Package Design Mode is active you can modify, add, or remove any of the Package Parameters shown
in the following figure.

Value Description
TEMPREGISTER 1 Temp Register Value

COMPLIANCYPATH MDocshe... Compliancy path

PTTFOLDER CAPTT Location of the CA\PT™ folder
PETSPTTFOLDER MEdensio... Location of the PTT fdder that in PETS path
TEMPFOLDER CATEMP Location of the C:ATEMP folder
SYSTEM3ZFOLDER C:\Windo... Location of the C:\Wirdows"system32 folder
POWERSHELLFOLD... |C:\Windo... Location of the PowerShell.exe
CONVERSIONSTAT... |NotSet
EXECUTECONNECT... |false
WINVER 100
TCPBINDINGTIMEOD... |200
BASEADDRESS 3]
NUMBEROFVSC 0
DESTROYVSCSBEF... |true
VSCKEY
VSCINDEX ROOTS...
FULLINGNUM3ERO ... | 150
PULLINGDELAYTIME
VERIFYAGENTTIME. ..
SPECIALDELAY
APSDELAY
SOTOSODELAY
SOTOSEDELAY
SOTOS4DELAY

Cument conversion staus

Cument conversion staus

Manufacturer Version to check

TCP binding timeout in seconds

base address for TPM 2.0

Stare number of V5C installed

Destroy all VSCs Before Start

Holder for the WSC Key

Holder for the WSC device index

Mumber of times to pull for encryption or decryption status.

Delay time between pulling for encryption or decryption status.

Timeout for verifying lozal agent is on
Delay after full Encrypton/Decryption

Maximum allowed time for Intel® APS response.

Maximum allowed timefor S0to S0 transition.

Maximum allowed timefor S0to 55 transition.

Maximum allowed time for S0 to 54 transition.

LR R A A R A R R A RN N A R A R R A R R A RN RN S
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9.4.2 Configuring Step Parameters

1. Access the Properties tab of the Package Design Mode panel.

2. Select a parameter to modify.

3. Do one of the following:

. Insert an immediate value.

. Click on the Browse symbol next to the parameter and select a value from the Package Parameters or

the previous Step Parameters tabs

(SiBR Propertes |
BringToBaseSiate
Choose from:
Description: |Bring the machine to 50 |
- Previous Step Parameters ‘
Failure Behavior: |Inherit v|
D Test Step Parameter Name
Use Local Agent: |Fa|se V| 1 BringToBaseState SkipMeChecks
SkipLocalAgentChecks
Sub Test Name: | A| SkipPingHostOs
\ SetMeldie TimeOutMor ThanOne
Bring To BaseFail
Parameter I Value ”7 : nn‘g" _O sseraluE
SkipMeChecks ] UseWirsless Address
SkipLocalAgertChecks ] lsDeepSxDisabled
SkipPingHostOs L. | Timeout
SetMeldle TimeOutMor -] Bring ToBasePing TimeOut
Bring ToBaseFailure : PollingMeByNetwork TimeOut
UseWirelessAddress :
IsDeep SxDisabled L |
Timeout L |
BringToBassPing Time... Lo |
PollingMeByMetworkT .. L |

9.5 Modifying Test Properties

Right-click a test and select Properties. The Test Properties dialog appears, enabling you to change the test
properties.

The test is modified according to the user's changes.

—— | Test Properties
Mews

Deleze
Clane Name: |ME_PM_1
Mave Uip

Mave Davn Descripticn: |5DfCI'~'Iﬂto S3/C MOt
Ungelect Test
Select All Tests Prerequistes | Power 53
Select All Autoenated Tests
Unzelect 4] Tests

Eeparl
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9.6 Cloning a Test

intel.

You can clone tests within a package by creating copies of all the test steps, including step parameters, and

applying the same settings.

To clone an existing Test:

1. Right-click the desired test and select Clone.

Properties...

Mew

Delete

Clone

Move Up

Move Down

Unselect Test

Select All Tests

Select All Autormnated Tests
Unselect All Tests

Report...

2. Enter a uinyuc nanic 1ur uic niew weou

3. The test and its steps are cloned, including all the step parameters.

9.7 Removing a Test or Test Step

1. Right-click the desired test/step and select Delete.

Properties...

Mew

Delete

Clone
Move Up

Move Down

Unselect Test

Select All Tests

Select All Automated Tests
Unselect All Tests

Report...

2. The test/step is removed from the test list. The step IDs are rearranged and the Steps Grid Header is

updated.

Note: If any following steps use the step you wish to delete, the system prompts you for confirmation before

proceeding with the deletion.
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9.8 Moving a Test or Test Step Up/Down

To rearrange (reposition) items within a test list:

ntel)

Drag and drop the desired test to the desired position in the list or right-click the test and select Move Up or

Move Down.

Properties...
MNew

Delete
Clone

Move Up

Mowve Down /
Unselect Test

Select All Tests

Select All Automated Tests

Unselect All Tests

Report...

If any following steps use the step you wish to reposition, the system prompts you for confirmation before
proceeding with the move.

9.9 Modifying an Existing Package

You can modify an open package and apply the changes as needed.

To edit an open/existing package:
1. If the package is not open, choose Package > Open from the Package menu to open the package.

2. From the main menu, choose Package > Edit

Intel Confidential
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[ Intel(R) Platform Enablement Test Suite

Open...

Recent Packages

Save As...

Save

Settings _ Run

Ctrl+0

Report

F12
Ctrl+S

3.
4,

From the Open window, select a package.
Make the desired changes using the editing tools.

Ctrk+N ‘ Diescription Failure Behavior | Status
s Hoot Guard Boot Status Check Inherit M MatRunning
un Multiple

SR e Error Status Code check ] Inherit ~|  NotRunning

Package Parameters..

Exit

" "

Run_| Test Step Name Diescription Params | Failure Behavior | Status

BringToBaseState % Bringthe machine o S0 Inherit ~|  NotRunning
M | verifyPlatiormDevices ‘erify platform devices status fram the device manager Inherit bt MNotRunning
I | TBReadReisterFromPeics FWETS6 Inherit bt MotRunning
M | TBGeiBitField FWETS6 FACB 6 Inherit bt MNotRunning
M | TBGeiBitField FWWETS hits [6:9] 6 Inherit bt MotRunning
M | TeGeiiField FWSTS hits [31] Inherit bl NotRunning
B | o Inherit ~|  MNotRunning
M | comvercetBitField Convertinteger hit value to string Inherit bl NotRunning
B | updatesiobalParameter Update global parameter o Inherit v|  NotRunning
B | convertzetBitField Canvertinteger bitvalue ta string Inherit v MotRunning
M | UpdateGlabalParameter Update global pararneter Inherit v NotRunning
M | convensetpitField Convertinteger bitvalue ta string Inherit v NotRunning
M | UpdateGlabalParameter Update global pararmeter o Inherit v NotRunning
M | TBGetBitFieln M BootStatus Inherit o MotRunning
M | TBGeiBitField M BootStatus Inherit fot MotRunning

The Edit Package option is only active if you have a package open in the GUI.
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9.10 Saving a Package

When Package Design Mode is active, PETS checks if the package has been modified. In this case, PETS
prompts you to save unsaved changes.

To save the changed configuration of a test package as an original version:

e Choose Package > Save.

Intel(R) Platform Enablement Test Suite

Package | View  Settings FRun Report T

Open... Ctrl+C
Recent Packages

Save As... F12

Save Ctrl+5

Mew Ctrl+M

Edit ‘
Run Multiple

Find Test Case... Ctrl+F
Package Pararmeters..,

Exit

Typically, you can use this function when editing an existing package and you wish to save changes as you
work (prevent loss of information if a crash occurs). Save replaces the original file.

Intel Confidential
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To save the changed configuration of a test package as a new version:
1. Choose Package > Save As.

|E| Intel(R) Platform Enablement Test Suite

Package | View  Settings FRun Report  To

Open.. Ctrl+0
Recent Packages

[ savess. F12
Save Ctrl+5 BootGuard.
Mew Ctrl+M [
Edit

Run Multiple
Find Test Case... Ctrl+F

Package Parameters...

Exit

When you have created a new package from scratch or you are basing the new package on one you have
already opened/edited. This is useful if you want to save an existing package with a new name and then
make changes rather than start from scratch. Save As leaves the original package unchanged.

2. Enter the name of the new package in the Name field of the Save As dialog.

3. Specify the desired location and click Save. The new version of the test package is saved in the desired
location.

PETS prevents you from saving an invalid package with a prompt message explaining the reason. The
Package might be invalid for one of the following reasons:

e Atestin the package has steps that use an invalid or non-existent package parameter.

e Ateststep is trying to read an input parameter from a step that does not exist.
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10 Running Multiple Packages

The PETS framework enables you to run multiple packages and save all the test results in an Excel file. This
facilitates running automated tests overnight and reviewing the results when convenient.

Note: To use this feature, you must configure a SUT with an Intel® PETS Automated Power Provider and this should
be initialized; if the Power Provider is not Configured correctly, the menu item Package > Run Multiple is
disabled.

To use run multiple packages:
1. Click Package > Run Multtiple.

[ﬂ Imtel(R) Platform Enablemnent Test Suite

Package | View Sethngs FRun  Report

Open... Cirl+ O

Recent Packages

Save As... F12

Save Ctrl+5

e e | Dezcription

Edi

Boot Guard Boot Status Check
Error Stalus Code chack

Find Test Case... Ctrl+F

Package Parameters...

Exit

The Run Multiple Packages panel appears on the left side of the PETS interface displaying all the packages in
the default directory of the selected SUT.
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[ el latior £nch .
Package View Settings Run Report Tools Help Pre-Production SW for testing purposes onl;

. - Power Operations. Power Sources.
1 [Foor] cewcnos J[ sc [acoc] = D
=D D | EED

RunMultiple Packoges |

Packages Directory: 1D |Run |TestName | Description | Repeat| Failure Behavior _ | Status
C:\Program Fles 86)\el\reei) Pit ([N
Results Directory
CAProgram Fies &e6rtelnel) Pt ([N
Run automated tests only

Run Name. Status
etupenonmentrest i NotRurring
Compiance_MeSios.xnl NotRurring
Compiance_MeSios_Manufactringhode....  Not Runring
Compiance_SpFlashConfiguraton i Not Runring
Camplance_MECommonservices.xml NotRunning
Complance_AMT.xml NotRunning
Complance_Poner_G355.xml NotRunning
Complance _Poner_RST.xml Not Ruming
Complance_Poner_Network Wakexm Nt Ruming
Complance Poner_G350.xml Not Runving
Compiance_ME Poer_Gating.xnl Not Runving
Complance ME Poner_Gating_Network ... Not Runing
P _Stress Testingxml Not Runving
Compiance_1CC_Houmi NotRunring
Compiance.1CC 1P xnl NotRunring

Not Runing

1D |Run | Test Step Name | Description | Params | Failure Behavior | Status

EEEE

NotRunring

NotRunring
Complance BootGuard.xmi NotRunring
Compiance TPT.xml NotRunring
Complance IntelR)_Authenticate. NotRunring
Complance Pss.xm NotRunring
Complance_Power_G3-55_WoWLAN.xml  Not Running
PM_Stress_Testing_WoWLAN.xl NotRunring

SRSRCRCRCRCRCRCRCRSRSRSRSRSRS

(WLAN: 192.168.1.101) _Local Agent: O Avalble (Version:.142) _System State: S0 ME State: MeOn_Power Sources DC_Elapsed Test Step Time: 00 00004

2. Setthe Packages Directory (where package/s XML files are stored) and Results Directory (where tests
results are stored.)

Run Multiple Packages |

Packages Directory:

C:A\Program Files (<86)\InteN\Intel(R) Plat -

Results Directory:
C:\Program Files (<86)\intelintel(R) Pizt | [

Run automated tests only

# Run MName Status
1 SetupEnvironmentTest. xml Mot Running
2 Compliance _MeBios, xml Mot Running
3 Compliance_MeBios_ManufacturingMode.... Mot Running
4 Compliance _SpiFlashConfiguration. xml Mot Running
5 Compliance_MECommonServices. xmi Mot Running
3 Compliance _AMT . xml Mot Running
7 Compliance_Power_G3-55.xml Mot Running
] Compliance_Power _RST.xml Mot Running
g Compliance_Power _Metwark_Wake ., xml Mot Running
10 Compliance_Power_G3-50.xml Mot Running
11 Compliance_ME_Power _Gating. xml Mot Running

3. Check Run automated tests only to run only automated tests or clear this option to run all the selected
tests both manual and automated).
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Run Multiple Packages |

Packages Directory:

C:\Program Files (<86} \IntelIntel(R) Plat -

Results Directory:

ogram Files (B6j\rtentel(R) Plat | I

automated tests only

00w vt L po

Run

<

B EEEEEE

MName

SetupEnvironmentTest. xml Mot Running

Compliance_MeBios, xml Mot Running
Compliance_MeBios_ManufacturingMode. ... Mot Running
Compliance_SpiFlashConfiguration. xml Mot Running
Compliance_MECommanServices. xml Mat Running
Compliance_AMT, xml Mat Running
Compliance_Power_G3-55.xml Mot Running
Compliance_Power _RST.xml Mot Running
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C:\Program Jles

RunMultiple Packages |

Packages Directory:
C:\Program Files $«86AIntelhintel(R) Plat E

Results Directory:

irtel\Inte! (R) Plat E

Run auffomated ksts only
# Run Name Status
[/
2 Compliance_MeBios.xml Not Running
3 = Compliance_MeBios_ManufacturingMode....  Not Running
4 Compliance_SpiFlashConfiguration. xml Not Running
5 Compliance_MECommonServices. xml Not Running
3 Eompliance_AMT,xaml Not Running
7 = Compliance_Power_G3-85.xml Not Running
8 = Lompliance_Power RST.xml Not Running
9 = ompliance_Power_Network_Wake. xm Not Running
10 ompliance_Power_G3-50.xm| Not Running
11 ompliance_ME_Power_Gating.xml Not Running
12 ompliance_ME_Power_Gating_Network_...  Not Running
13 = _Stress_Testing.xml Not Running
14 ompliance_ICC_H.xml Not Running
15 ompliance_ICC_LP.xml Not Running
16 = Fompliance_DAL.xml Not Running
17 & [ompliance_NFC,xml Not Running
18 compliance_PTT.xml Not Running
139 ICompliance_BootGuard.xm| Not Running
) = Compliance_IPT.xml Not Running
211 Compliance_Intel{R)_Authenticate. xml Not Running
2 = Compliance_PSS.xml Not Running
2 = Compliance_Power_G3-55_WoWLAN.xml  Not Running
24 PM_Stress_Testing_WoWWLAN,xml Not Running

ry:
meliiel(R) Pit| |
reelntel(R) Plot| [
Is only
Status
mentTest, xml Mot Running
eBios. xml Mot Running
eBios_Manuf... Mot Running
BpiFlashConfig... Mot Running
ECommonSer...  NotRunning
BMT . xm| Mot Running
ower_G3-55.xml Mot Running
ower_RST.xml Mot Running
'ower_Networ...  NotRunning
ower_G3-50.xml Mot Running
esting. xml Mot Running
CC_LP. xml Mot Running
DAL, xml Mot Running
NFC.xml Mot Running
PTT.xml Mot Running
BootGuard.xml Mot Running
PT.xml Mot Running
S35, xml Mot Running
'ower_G3-55_... NotRunning

intel.

Select or deselect packages, drag-and-drop packages to change the order of execution, and click the
Play icon.

When you make changes to any package, the system prompts you for confirmation before proceeding.

I Test Marme Description Repeat
1 ME_PH_1 S0/CMN to S3ACK-OFF [
2 ME_PM_2 SCM-Of t0 SOICMO |
3 ME_Ph_3 SOMCMO o S3CM3 I
4 ME_Ph_4 53ICM3 to SOCHMD 1] I
5 ME_Ph_5 SHOM3 to SHCH-OF fwithout Intel® ME ¥Wake) ]
& O | ME_PM_5 SCM3 tn SUCH-OR fwith Intel® ME Wake) |
7 [ | ME PM_7 SHCM-Offto S3CM3
] ME_Phi_8 S0/CMO o SACH-OF
9 ME_PM_g 33, 0F S4-5/CH-Off to SOCMD
10 ME_FM_10 S4-5ICH-0MGuspend Well On) to SLCMD

-

Question

& Do you want to save changes made in package: "Compliance_Power_G3-S5xml"?

JHHEHHHHHHE

Run | Test Step Mame Description
1 [] | BrinaToBasestate 3?.} ME_PMW_7.1 - S3CM-Off to S3/CM3 {wake ME by ping, PP2, ACDC, Sta
2 [ |PP_oNinS0_MEWDLINS35455 B SetPP2
3 [ |acoc % Setthe machine to ACDC
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PETS runs the packages and displays a progress bar beside each package.

Intei(R) Platform Enablement Test Suite
(m'nm\ L)
- D | EER
it Pockares | | 3 Pacione tcomotanse. Maios i 4 seats IUENCEL Ui doncslCormoreiboblielitrsd oot ___]

Packages Directary: |Run | Test Mame  Descrigtion Status__
(C:Program Fiee Ehrtal o Pt [ 1 | @ eoson Gheck thal End of POST was sent (posbmanufactit v am
Results Dirsctory: & [posn Hinglunlacking - nan Manufacturing Modd| 1 et |v|  NoRunning
€ Program Fls popiria Pt [ @ | B0 Ghisckihe DRAM ind Done bif rrE R
W Run atomated tests only @ |ens_os PCISID and SVID programming test Innent ¥  romunning

Comphence BootGuerd.d ol o D |Run_|Test Siep Name.

1 | @ |eingToBasestate
“

Descnghian Params | Failre Behavior

Bring the maching to 80 Inherit
[ Inhert
Tanent

O e

U R UV Y CY R VR Y OO LV R W CU CO R O

EWoLINSI3485

o © olw

ST message before the BIOS b Inherit

Pé| FEFPEFEE

)
i
el ls sl tel=l=1s

(LAM: 192.168.1.100) System State: G3 ME State: McOFf Power Source: G3 Hapsed Test Step Time: 00 000002

5. When a package has completed execution, you can click its status and open the standard PET results
log.

- T ¢

FunMutiple Packeges | P > .
Packeges Direcory: D |Run | TestName _|Descigiion Repeai| Faiue Beharior | Stalus
¥ mos0 Check hat End of POST was sent (postmanutactur 1 || Innent J o

whett |v| NoRunning

2 | @ 2 Jriocking - non Mnufschuing Mode,
Cerogran s e et e P [ » | &= ek he DRAM it Do

¥ automated tests ey ¢ | @ |mosss PCISOANESVID. programming fest

]
| Inhert
]| nhent

otRunning

=
Comhance_ICC_LP s
Comghance DAL sl
SetupEmironmentTestxm Q) Passed

Conghance Mefios, Manif... ot Rurving
Comeliance_SoFlashCant. Mot Rurving
¥ Comphance MECommanses... Mot Rurving
Conphance_aaer sri Nt Rurring
i Comglance_Power_G355.5m Not Rurning
Complance Powes_RST ol Mot Rarving
Comglance_ Powes_Netwar... NotRurving
Comlance Powes G350l NetRureing
#M_Stress_Testng.ami NotRurnng
Compiance J0C_Hami NotRurring
Conglance NCm NotRurring
Comeliance PTT el Mot Runng
Complance BootGuardoml Mot Rurving
Comphance JPT.xwi
Congisnce PSSl
Comehance Power_G355....

| Run__ Tesi Sisp Name

EringTo@asestate

50_WEWoLInE364

INRENRER O EE

clefetelele

(LAN: 192.168.1.100) System State: G3 ME State: MeOff Power Source: G3 Hapsed Test Step Time: 00020002

PETS creates Excel logs simultaneously and stores them by default in the Results folder nested under the
packages folder.
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£ Recent places

AWS

1% This PC
# Desktop
| Documents
& Downloads
J Music
=] Pictures

# Videos

ca XP xB6 w/SP3 (D

- 2008 R2 x64 (1)

Intel(R) Platform

., 81 ENT 64 (GA)

- B.1ENT 86 (GA)
s DVD RW Drive (L: ,,

1L Wired_Only - oIEN
Home  Share  View 7]
® - 1 « KBL » Windows » Corporate » Mobile » Wired Only v ¢ | | Search Wired_Only »
[a] = i 7
i Fovoines Name Date modified Type Size
Bl Desktop Result 12/27/2015 1:19 PM  File folder
& Downloads = Compliance_AMT.xml 27227201 XML Document

ca 2003 x88 w/SP1 (1
a7 ENT x86 w/SP1
a7 ENT x64 w/SP1
Ca 2008 %86 w/SP2 (I
a 2008 x64 wySP2 (I

Compliance_BootGuard xml XML Document

Compliance_DALxml XML Document
Compliance_ICC_Haxml XML Document
Compliance_ICC_LPaml XML Document
Compliznce_PTaxml ¥ML Document
Compliance_MeBios.xml XML Document
Compliance_MeBios_ManufacturingMod... XML Document
. Compliance_MECommonServices.ml XML Document
Compliance NFC.xml XML Document
Compliance_Power_G3-SDxm XML Document
Compliance_Power_G3-S5xml XML Document
Compliance_Power_G3-55_UnProvision.x... ¥ML Document

XML Document

| Compliance_Power_Network_Wake.xml
[ Compliance_Power_RSTaml XML Document
Compliznce_PSSaxml XML Document
Compliance_PTT.xml XML Document
Compliznce_SpiFlashConfiguration.xml XML Document
| PM_Stress_Testing.xm

2 SetupEnvironmentTestaml

XML Document

XML Document

21items 1 item selected
IS Result -
®© - 1 <« KBL » Windows » Corporate » Mobile » Wired_Only ) Result v ¢ SearchResult »
X Eavorites Name - Date modified Type Size
B Desktop B Compliance DAL 2015.12.27_13.13.575pr.
& Downloads B Compliance ICC_LP_2015.12.27_13.11.55...
] Recent places B Complisnce ICC_LP_2015.12.27_13.1351...
¥ Syneplicity B Compliance_MeBios_2015.12.27_13.14.06.
@ Creative Cloud Files & SetupEnviranmentTest 2015,12.27 13.14.., Micrasoft Excel 97...
18 This PC
€W Network
5 items

e The Skipped status is displayed if the package has no automated test (all tests are manual) or if the
tests have been deselected.

e The Passed status is displayed if all the tests passed successfully.

e The Failed status is displayed all package tests failed.

e The Partially Failed status is displayed if some tests failed.

e The Aborted status is displayed when the user clicks Stop.

e The default value for the Packages Directory field is the default package folder for the selected

SUT.
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11 Changing SPI Flash Parts Manufacturer

Specifications

ntel)

Starting with PETS version 5.10.0, TXE SPI flash parts manufacturer specifications are now stored in an XML
file named "TXESpiFlashManufSpecs.xml". This file can be found in the root folder of PETS Local Agent.

Migrating to XML should provide the ability for PETS customers to add their own SPI flash parts

specifications to be checked during related tests (e.g., SPI_004).

12 Adding Specifications

To add your own specifications:

1.

5.

Locate the file named "TXESpiFlashManufSpecs.xml" at "(Program Files Directory)\Intel Platform

Enablement Test Suite Local Agent\"

Edit the file with your favorite xml editor. (Recommended: Notepad++)

Scroll till the end of the file, and make sure whatever you want to insert (from the next step) will be

before the </SpiFlashDevices> tag.

Use this example to guide you in entering the properties of your SPIFlashDevice.

<SpiFlashDevice>
<DeviceName>MX25U6435F</DeviceName>
<ManufName>Micron</ManufName>
<Manufld>C2</Manufld>
<Jedecld>C22537</Jedecld>
<FlashSize>8388608</FlashSize>
<FlashSpeed>50</FlashSpeed>
<FlashBlockEraseSize>4096</FlashBlockEraseSize>
<Vsccs>
<Vscc>2005</Vscc>
<Vscc>2001</Vscc>
</Vsccs>
</SpiFlashDevice>

Save your changes.

12.1 Validating XML Contents

The validation of the XML contents is done during the test that uses the XML file. For example, if you make a
mistake in one of the tags while entering your information, PETS should indicate the exact tag that is missing,
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as shown in the following example:

B @ NewSpiFlash.TBReadSPIFlashinfoFile
( 12 ) Read Flash device spec from XML file

T S/E2013 12:56:42 Pl
Action
==ERROR==
Result
ERROR LOAD_FILE_FAILED (Status code OuF004); Failure to load SPI flash devices manufaciurer
specific
ations from XML file iz due to following:

The Vsccs' starttag on line 89 position & does not match the end tag of

‘SpiFlashDevice’. Line 92, position 5.

at System.Xml.XmiTextReaderimpl Throw(Exception e)

System.Xml.XmiException =

at System. Xmil XmiTexdReaderimpl Throw(String res, String(] args)

at System Xml XmiTextReaderimpl ThrowTagMismatch{ModeData stariTag)

at System.Xmi.XmiTextReaderimpl ParseEndElement()

at System Xml XmiTexdReaderimpl ParseElementContent()

at System Xml XmiTextReadermpl Read()

at System.Xml XsdValidatingReader Read()

at System.Xmi.XmiLoader.LoadMode(Boolean skipOverWhilespace)

at System. Xxml XmiLoader LoadDocSequence(XmiDocument parentDoc)

at System Xml XmiLoader Load(XmiDocument doc, XmiReader reader, Boolean preseneWhitespace)
at System.Xml.XmiDocumentLoad(XmiReader reader)

atvProSystemAccessLib Platforminfarmation LoadSpiFlashManufSpecs(String xmiFileName, String xsdF
ilerame, String xsdiameSpace)

Otherwise, the test will successfully load all the parts found in the XML.
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A. Intel® Platform Enablement Test Suite Package
List

A.1 Introduction

This document lists the packages provided with Intel” Platform Enablement Test Suite, and includes the name of
the XML file of each package.

Note that some packages require you to have the Intel’ PETS Automated Power Provider connected to the system
under test. These packages are marked as such in the document. The other packages can be run without an Intel’
PETS Automated Power Provider.

When you load a package into Intel’ Platform Enablement Test Suite, the tests included in the package are listed in
the main window. The package's tests map directly to tests in your Intel” AMT platform’s Compliancy Requirements
and Testing Guide, which contains a detailed description of each test.

Note: For most packages, each Test Name maps to the Test ID of a test in the Compliancy Requirements and Testing
Guide. The exception is the Setup and Configuration package (SetupEnvironmentTest.xml); for details on the tests
in this package, see section: 5.4.1

A.2 Package List

Test packages are arranged by folders, as follows:
e PCH
e Operating system (OS) for some platforms
e Firmware size
e Desktop/mobile/workstation/All-in-one/Mobile-H
e Wired_and_Wireless/Wired_Only/Wireless_Only
e A full list of relevant packages and tests

For example, clicking the Package Open menu for CoffeeLake (CFL) opens a dialog showing the supported PCHs,
as described below:

2 CFL
E Windows
2 Consumer
B Desktop
Wired_And_Wireless
Wired_Only
Wireless_Only
Mobile
Mobile-H

Corporate
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The packages themselves bear simple names, whereas in the past their names reflected all of the above options.
Below is a complete list of the packages that are included in different folders. Only packages relevant to that
folder will be included, and only tests relevant to that folder will be included within the packages (i.e., a package in
2 different folders may not have the same contents, even if it has the same name).

The Test Packages include:

ME Packages
e Platform Controller Hub (PCH) SoftStrap Configuration
(Compliance_PSS.xml)
¢ Intel® Platform Trust Technology
(Compliance_PTT)

e SPI Flash Configuration
(Compliance_SpiFlashConfiguration.xml)

¢ Intel’ Management Engine BIOS Compliancy (Compliance_MeBios.xml)
This package requires that the Intel’ PETS Automated Power Provider be connected to the system under
test.

e ME BIOS Manufacturing mode package (Compliance_MeBios_ManufacturingMode.xml)

This test runs in pre-manufacturing mode.

e Setup Environment Check of Intel” Platform Enablement Test Suite (SetupEnvironmentTest.xml)

Checks ME Connectivity setup, Local Agent and SUT connectivity setup, and the Intel" PETS Automated
Power Provider setup.

Should be run after Intel’ Platform Enablement Test Suite is installed and whenever the environment is
changed.

This package requires that the Intel’ PETS Automated Power Provider be connected to the system under
test.

For details on the tests in this package, see section: 5.4.1 "Testing the Configuration of the SUT".

e Intel’ AMT Tests
¢ Intel’ AMT and KVM Compliance (Compliance_ AMT.xml)
e Secure Boot package (SecureBoot.xml) Part of Compliance AMT.

¢ Intel’ Management Engine FW Power Management - BIOS Setting: S5 after Exiting G3
(Compliance_Power_G3-S5.xml) (Compliance_Power_G3-S5_UnProvision.xml)

This package requires that the Intel’ PETS Automated Power Provider be connected to the system under
test.

Before running this package, you need to ensure that the BIOS settings on the platform under test cause it to
transition to S5 after it exits G3.

¢ Intel’ Management Engine FW Power Management - BIOS Setting: SO after Exiting G3
(Compliance_Power_G3-50.xml)

This package requires that the Intel’ PETS Automated Power Provider be connected to the system under
test.

Before running this package, you need to ensure that the BIOS settings on the platform under test cause it to
transition to SO after it exits G3.

¢ Integrated Clock Controller (ICC) - H (Compliance_ICC_H.xml)
¢ Integrated Clock Controller (ICC) - LP (Compliance_ICC_LP.xml)
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PM with WOL tests

(Compliance_Power_Network_Wake.xml)
This package includes PM tests with trigger of WOL (Magic packet) and Deep SX disabled.

This package requires that the Intel’ PETS Automated Power Provider be connected to the system under
test.

ME Common Services (Compliance_MECommonServices.xml)

This package requires that the Intel’ PETS Automated Power Provider be connected to the system under
test.

Intel” Dynamic Application Loader (Intel” DAL) (Compliance_DAL.xml)

This package includes the DAL tests in the Compliance Guide. It is used for testing PM flows in Power Policy
2.

Before running these packages, you need to ensure that the BIOS settings on the platform under test cause it to
transition to S5 after it exits G3.

Before running these packages, you need to ensure that the BIOS settings on the platform under test cause it to
transition to SO after it exits G3.

ME Power Gating tests

(Compliance_ ME_Power_Gating.xml)

(Compliance_ME_Power_Gating_Network_Wake.xml)

(Compliance_ME_Power_Gating_Provision.xml)

Before running this package please make sure that the system is configured to Connected standby mode.

Intel” Power Reset (Compliance_Power_RST)

Intel” Authenticate Solution (Compliance_Intel(R)_Authenticate)

Intel” Boot Guard (Compliance_BootGuard)

Intel” Power Wake On Wireless LAN tests (Compliance_Power G3_S5 WoWLAN) (Coexistence mode)
Intel” ME Power Management Stress Test Coverage Summary (PM_Stress_Testing

Intel” Wake on Wireless LAN Stress tests (PM_Stress_Testing WoWLAN) (Coexistence mode)

TXE Packages
TXE Compliance MFM (TXE_Compliance_MFM.xml)
This package tests certain BIOS operations that are not performed when TXE is in Manufacturing Mode.
TXE_Compliance_SpiFlashConfiguration (TXE_Compliance_SpiFlashConfiguration.xml)
Test Environment for Serial Flash (SPI) Configuration.
TXE Compliance PM (TXE_Compliance_PM.xml).
This package provides detailed tests for TXE FW Power Management.
TXE Compliance PM RST (Compliance_Power_RST.xml).
TXE Compliance PM Stress (Compliance_Power_Stress.xml).
TXE Compliance Signed Master Image Profile (Compliance_SMIP.xml).
TXE Compliance ISH (Compliance_ISH.xml).
TXE Compliance BIOS (TXE_Compliance_BIOS.xml)

This package serves as a checklist for the environment setup for the host BIOS and Intel’ TXE interface
testing and validation.

TXE Compliance PTT (TXE_Compliance_PTT.xml)
This package tests the implementation of TCG TPM 2.0 standard in firmware.
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TXE Compliance Audio (TXE_Compliance_Audio.xml)

This package tests general audio functionality including Bluetooth and HDMI audio.
TXE Compliance Wi-Fi (TXE_Compliance_WiFi)

This package provides test cases for Wi-Fi / WLAN functional tests.

A.4 Modifying PETS Configuration file

The name of the PETS configuration file is “IntelPlatformEnablementTestSuite.exe.config”. It can be found under
PETS console installation directory.

A.4.1AMT connection timeout

The AMT connection timeout is separated in PETS configuration file into two different keys, one for the LAN and
the other one for the WLAN. The configuration keys are:

1. “WSMANTimeoutLAN" with default value of 10 seconds for LAN
2. “"WSMANTimeoutWLAN" " with default value of 30 seconds for WLAN

In most cases, these values can be ignored unless “Unable to connect” error messages are seen in the Intel® AMT
test steps. When such errors occur, which would be due to connection instability, you can adjust these settings
and expand the timeout as needed.

Note: Expanding the default timeout will impact the time needed to stop or pause the related test steps and PETS might
take more time than usual during the stop or pause operations.
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